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1 Overview of the Report Module 
Report module is the application for the reports viewing. It is only possible to view reports 

and add new pages to them, it is impossible to add or remove the report. 

After launch of the application and successful log on you will see the main window of the 

report module: 

 

You can see 2 tables to the left: “List” and “Settings”. You can see all available reports in 

the tree view on the “List” tab. On the “Settings” tab you can find data about your PC and about the 

user under which you’re logged on to Windows. 
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 Language Selection 1.1

In order to change the language of the interface you need to enter the “Tools / Language” 

menu item and select the necessary language: 

 

 Themes 1.2

Theme (or skin) defines the outer view of the report module. You need to enter the 

“Tools/Look and Feel” menu item and select any theme of more than 10 possible themes: 
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2 Viewing Reports 
There exist two kinds of reports – an interactive dashboard and a report: 

 

Now let’s have a look at each of them separately. 
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 How to open a report? 2.1

You can open a report in one of the following ways: 

 

In order to open a report you have to do one of the following actions: 

1. Double click on the report with the left mouse button; 

2. Make the report active in the list and press Enter. 

3. Press the button «Generate» in the bottom part of the screen or in the toolbar, or in the 

context menu opened with the help of right mouse button click. 
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When the report is opened, you will see an additional tab “Reports” added to the set of tabs: 

 

All generated reports will be placed on this tab. Note: you can generate several reports 

simultaneously. All generated reports will be placed on separate tabs and their location can be 

changed:  

 

You can close the report using the cross icon in the upper right corner. 
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3 Report Pages  
Each report consists of several pages. To understand better what is the report page, let us 

recall how Excel document looks like: each page has a table with data. Pages are displayed as tabs 

in the bottom part of the window: 

 

Each page can have one of the following types: 

 Pages created by administrator (red color) 

 Pages created by you (blue color) 

 Pages created by you and shared with other users (blue color with green border) 

 Pages created by other users which were shared with you (green color) 

 

You can view administrator’s pages and shared pages, and change their structure, but you 

have no right to save them. However, you can copy those pages and save yours. 

You can add your own pages to any report. You can save all changes made on your own 

pages. You are the only one who can access your own pages (provided they are not shared by you), 

and no more users (even administrator) can view, modify or delete them. Next section of this 

document will show you how to create and delete pages.  
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You can also filter the viewed pages to see yours, administrator’s or shared, by pressing one 

of the buttons:  

 

4 Working with reports 

 Basic Navigation on the Page 4.1

To demonstrate the page navigation let’s open the report based on a test database of the 

retail sales: 

 

In the opened window you can see the following blocks: 

 Dimensions 

 Measures 

 Sets 

 Parameters 

 Context 

 Measures 
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We can see the product families on rows and quarters of the year on columns. Inside the 

table the total amount of sales is displayed. The items which are in rows and columns (products, 

time, etc) are called dimensions. The values inside the table are called measures. 

The section “Dimension” contains dimensions, hierarchies and levels: 

 

The hierarchies can be of several types: regular, attribute and parent-child: 
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You can see levels under the hierarchies: 

 

You can see the levels of a hierarchy by pressing “ ”: 
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With the help of “ ” and “  “ buttons you can expand the data to the desired level of details 

in the table as well: 

 

The level of details can be set in another way. You can see two shelves in the top part of the 

page: “Rows” and “Columns”. There are controls on them. Those controls allow us to know which 

data are displayed in the table. With the help of the dropdown you can set the necessary level of 

details: 

 

If you select some level of details, e.g. “Subcategory”, 

 

you’ll be able to made detailing greater or smaller with the help of the buttons + and – (to the left of 

the control). 
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To search in the hierarchy tree of measures and sets of a specific level/measure/set, a quick 

search is provided: 
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 Member Selection 4.2

 Manual Member Selection 4.2.1

There is a possibility to set arbitrary selection of the items not only by levels, but also with 

the help of this button: 

 

If you press it, you will get the member selector dialog. In this window there will be selected 

all those items which are displayed in the table: 
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You can see the whole level “Subcategory” selected. You can select several levels at once, 

for example: 

 

After you press «OK» you will get all three levels displayed in the rows of the table: 

 

Member selector can show the selected items in two ways: using levels and using elements. 

In order to view the selection using elements you have to select “Show Elements” in the context 

menu: 
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After this you will see the following: 

 

The list of categories is displayed by elements. Please, pay attention to the icons near the 

elements and sets.  

In the member selector window you can set the selection with combining levels and 

elements: 
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In order to make the selection as shown above you need to use the context menu which can 

be different depending on where you pressed the right mouse button: on the element or on the level: 

 

Context menu for the level looks like this: 

 

Context menu for the element looks like this: 

 

All actions in this menu are obvious – you can try any of them on your own. 
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As a result of the selection shown on the picture above you will get this report: 

 

As we can see, the table has all elements of the level “Subcategory” under the “Bikes” 

element, and three elements selected separately under “Clothing” element. 
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 Searching 4.2.2

In the member selector form you can search for necessary members: 

 

The button “Show Search / Hide Search” below opens or closes the search panel. On the 

search panel you can set the phrase, the level in the hierarchy where search will be performed (if not 

specified – the searching will be done on all levels) and the search mode: 

 Search by name: your phrase will be searched among member names; 

 Search by key: your phrase will be searched among member keys; 

 Search by property ‘х’: your phrase will be searched among values of the property ‘x’ of the 

members. 

You can specify several words using “;”. Each word can be started or ended with “*”. For 

example, type touring* if you want to find all goods which start from touring. If you need to search 

for symbols “*” or “;” you have to specify \ before them, like this: «\*» и «\;». In order to search for 

“\” you should specify “\\”. 

The option “Approximate searching” makes so that the application will search the words 

approximately. Thus, searching for «helmet;gloves» with checkbox “Approximate searching” set to 

“ON” is the same as searching for “*helmet*;*gloves*” without it. 
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After successful searching of elements, the member selector turns into “offline mode”. It 

means that the member selector will show ONLY the elements which are the search result plus their 

parents. You can unplug the “offline mode” pressing this button: 
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In the offline mode you can show only those elements which you need. Using menu items 

“Refresh Children” and “Refresh Subtree” you can display all children of the selected element or all 

its subtree: 
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 Filtering of Selected Elements 4.2.3

You can filter those elements which you’ve selected on the tab “Selection”. There is a 

second tab “Filter” which is used for this.  

Let us make an example: let us choose all mountain bikes which are in the top 10 by the sum 

of sales in the first quarter of 2007. In order to select them, please do the following. 

Choose all bicycles: 

 

Create a new filtering group on the tab “Filter”: 
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Fill in the data in order to select top 10 as shown on the following picture: 
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In order to make so that the “Reseller Sales Amount” is to be computed using the 1
st
 quarter 

of 2007 (but not all the time) you have to override context: press the button “Override Context for 

Hierarchy…” 

 

Choose the time hierarchy: 

 

Choose the 1
st
 quarter of 2007: 
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After pressing «OK» you will get this: 

 

Add one more filtering condition: 

 

In order to filter only mountain bikes fill in the following form: 
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All filtering conditions are set. In order to make so that both conditions are applied to 

selected members, you have to select the “And” join type: 

 

If you apply this filter, you will see the expected result: 

 

In the first condition you applied filtering by measure. In the second – using a property. 

When you’re filtering by measure value, you can select one of the following conditions:  

 

The list of available conditions: 

 Topmost members whose sum >= X% of the total; 

 Smallest members whose sum >= X% of the total; 

 Topmost members whose sum >= X; 
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 Smallest members whose sum >= X; 

 Members with value = Х; 

 Members with value <> Х; 

 Members with value > Х; 

 Members with value >= Х; 

 Members with value < Х; 

 Members with value <= Х; 

 Members with value in the range from X to Y; 

 Topmost X members; 

 Smallest X members; 

If you filter elements by property, the list of conditions depends on the type of the property: 

is it text, numeric or date. 

If the property type is numeric or date, the list of conditions is identical to the list for 

measure. 
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If the property is of text type, the list of conditions is as following: 

 Members with values satisfying mask (the mask is case insensitive; you can use 

symbol «*» in the beginning and in the end of the mask); 

 Members with values = Х; 

 Members with values <> Х; 

 Members with values > Х; 

 Members with values >= Х; 

 Members with values < Х; 

 Members with values <= Х; 

 Members with values in range between X and Y; 

 Topmost X values; 

 Smallest X values. 

It is possible to change filter status: 
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 Sorting of Selected Members 4.2.4

In most of the cases the dimension members are sorted by names, but you can override the 

method of member sorting. 

Let us build the following report: 
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In order to set up sorting, open the member selector and choose the tab “Sorting”: 

 

There are 3 options here: 

 Do not sort; 

 Sort all levels by a single criterion; 

 Sort each level by different criteria. 
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Let us sort the elements on the level Subcategory in descending order by Reseller Sales 

Amount in 2007. For this you have to select the last option – “Sort levels using different criterias”. 

Then select the tab which corresponds to the level Subcategory and switch on the sorting for this 

level: 
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Choose “by measure” and in the dropdown list choose “Reseller Sales Amount”: 

 

In order to take into account the values for the year 2007, you have to override context. For 

this press the button “Override Context for Hierarchy”: 
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In the dialog box select the “Date.Calendar” hierarchy and press «ОК»: 

 

Again press «ОК». You will have a member selector form where you have to select the year 

2007 and press «OK»: 
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Finally, choose the descending sort order and press «ОК»: 
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After this you’ll see that all elements of the level “Subcategory” inside each group are sorted 

in descending order by the value of “Reseller Sales Amount” in the year 2007. 

If you expand another product category, you will see that the elements on the “Subcategory” 

level are sorted in the same way. That is, the sorting is applied to all members of the selected level 

(in this case – “Subcategory”) inside the categories: 
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 Additional options 4.2.5

4.2.5.1 Option “Show Parent Elements” 

If you want to see for each element its parent elements, you don’t obligatory need to include 

the parent elements into selection. You can use the option “Show Parent Elements” on the tab 

“Options” of the member selector form: 

 

If you select this option, you will be able to set up the topmost level of the visible elements: 
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Select the level “(All)”, go to the first tab “Selection” and uncheck all parent elements:  

 

Close the member selector form by pressing «ОК». You will see that the parent elements are 

visible in the captions of the rows: 

 

4.2.5.2 Option “Display Mode” 

On the “Options” tab there is one more useful option – possibility to display properties of 

elements in the table.  

Select any set of goods in the member selector, for example:  
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Open the “Options” tab. Select the radio button “Advanced”:  
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Find the property “Standard Cost” and add it to the list of displayed properties, and press 

«OK»: 

 

As a result, you will see prices near each product:  
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You can set up several properties to display. Let us add the ID of the goods before its name. 

Go back to the “Options” tab and add the property KEY0 to the displayed list and move it before 

the “Elements Tree” using the “Up/Down” buttons: 

 

Press «ОК» and you will see the following report:  
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As you may see, to the left there are IDs of the goods, to the right – their prices.  

You may have noticed that for quick displaying of the IDs and names there is a special mode 

“Key and Name”: 
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 Selection in the Table 4.3

You can select the necessary items with the help of context menu (opens with the right 

mouse button) in the table:  

 

We invoked the popup menu for the “Bikes” item on the picture. Let us look at every 

possible action.  

The action “Show By” changes the structure of the table. Therefore we will look at it in the 

next section.  

 Drill Up/Down 4.3.1

Operation “Drill down” makes so that the selection goes inside the element on the deeper 

level. If we apply it for “Bikes” we will see all product subcategories which belong to the “Bikes” 

category: 

 

Operation “Drill Up” is the opposite one to “Drill Down”. 
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 Hide Item, Hide Siblings and Show All Children 4.3.2

Operation “Hide Item” hides the item from the selection. If we apply it to the “Road Bikes” 

(as it is shown on the picture): 

 

the element will disappear from the table: 

 

In order to show all hidden elements under “Bikes” you need to select the item “Show All 

Children” for the “Bikes” element: 
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After that the element “Road Bikes” will become visible again: 

 

The action “Hide All Siblings” works in the same way as “Hide Item” with the only 

difference that it hides not the element itself, but the siblings of the element. 

Let us look at the example with more than 100 elements in the products list:  
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Let us assume we want to hide one of the products ( “Cable Lock” ): 

 

After opening member selector again, we will see what products we’ve hidden: 

 

This functionality is switched on only in the case when the group contains more than 100 

elements. 
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 Change of the Page Structure 4.4

 Page Structure 4.4.1

Under the term “Page structure” we mean all that information which describes what is the 

selection on the columns and rows, what is displayed inside the page, what is the format of the 

numbers, what filters and sorting rules exist, etc. If you were given enough rights by administrator, 

you will be able not only select the elements (as shown above), but also to change the page 

structure. 

First of all make sure that in the menu “View” under submenu “Designers” all designers are 

selected: 

 

If not all are selected – choose “Data and Designers” menu item.  

If you have no such menu items it means that administrator has restricted you from using the 

designers, so you may skip this section. 
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 Designers 4.4.2

All pages can be divided into several zones: 

 

The area which is selected with red represents all dimensions and measures. You can drag 

and drop their elements to areas which are selected with blue. The latter are called “designers” – 

they defined the structure of the page. 

There is the way to show or hide at once all designers in two ways: 

1. To press Alt+Enter on the keyboard. 

2. To press button ”Data and Designers” or “Only Data” on the toolbar: 
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3. Enter the “View” menu and select one of the items: 

 

If you have hidden all designers, the report will look like this: 

 

 Designer “Rows / Columns” 4.4.3

This designer shows what is displayed on the rows and columns. It is located in the upper 

part of the window above the table: 

 

On our example we see that columns display time, and rows display products. Let’s show 

how this can be changed.  
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Drag the item “Date.Calendar” on rows: 

 

During the movement process you can notice a vertical red line shown in the place where the 

item will be dropped. The result after the movement will be the following: 

 

Drag the element “Product” on columns in the same way. After these operations the page 

will look like this: 

 

You can drag and drop “Dimensions” and “Measures” (in the left part) on rows and 

columns: 
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Let’s drag the item “Reseller Type” on columns and drop it after “Product Categories”. We 

will get the following page: 

 

The sets of “Reseller Type” and “Product Categories” are “crossjoined” and thus the page 

allows us to see which product was sold by which reseller.  

In the same way you can combine arbitrary number of dimensions and measures on the rows 

or columns, getting arbitrary pivot table. 
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 Context/Global context 4.4.4

“Context” is the designer that limits the data which you’re watching. It is located to the left 

of the table: 

 

You can drag dimensions into context (the same when you do it with columns and rows).  
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Let’s assume we are interested in sales for “Miami”. Drag the dimension “Geography” from 

the “Dimensions” into “Context”. The member selector dialog will pop up: 

 

Select “Miami” and press «OK». You will get such report: 
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There is an item “Geography” in the context. It means that the table is currently displaying 

data for one city – Miami. In the same way you can drag other dimensions into context for making 

the selection narrower. 

“Global context” is the context which is applied to all the pages of the report: 

 

Only administrator can enable/disable global context. User can edit the global context (the 

bar will be painted yellow), but user cannot save his settings. User can revert his changes quickly by  

pressing the button  or by selecting this menu item: 

 

You can switch on/off the display of global context in the “View” menu: 

 

Global context has lower priority over the context of the page:  if the same hierarchy is 

present in the global context and in the page context, the MDX query will take into account the page 

context. 
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 Time Selection 4.4.5

The page may contain time dimension in rows, columns or context: 

 

Member selector for time dimension will have additional functionality:  

 

There are two radio buttons in the upper part of the dialog. If you select “Date Range” 

option you will have a possibility to set either fixed or floating time period. 
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If you use fixed period, you can set “from-to” date range. After pressing «OK» you will see 

the same selection in the table: 

 

 The floating period allows the user to analyze not only the past period, but also to set 

the sample for the next days/weeks/months/years or specify the time interval. In addition to this, it 

became possible to set the offset in relation to the current date. Thus, each time you open a report, 

you will see information for the selected period in relation to the date when you opened the report. 
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Let's look at a report example. Let's say the current date is September 1, 2007. The problem 

is that we need to analyze every day of sales for the last 5 days, starting from August 25, 2007. For 

this, the following parameters must be specified in the elements selection: 

 

 

A note for administrators: 

In order to make it possible to select in “Date range” mode it is necessary to design the dimension 

in appropriate way. The day key must be in format YYYYMMDD, the month key – in format 

YYYYMM, the week key – YYYYWW, the quarter key – YYYYQ, the year key – YYYY. 

Moreover, there must be a description for the hierarchy which “tells” the application what level is 

responsible for the day, what for the month and what for the year. For example: « [YMD=Day, 

YM=Month, YQ=Quarter, QW=Week, Y=Year] ». Day is the name of the day level, Month – of the 

month level, Year – of the year level, Week is the name of the week level, Quarter is the name of 

the Quarter level. It’s not necessary for all five level to be present in description. If the name of one 

of the levels contains spaces it should be enclosed in square brackets […]. 
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 Measures Designer 4.5

This designer allows you to set the measures that will be displayed in the table. The picture 

below displays only one measure – the store sales: 

 

Drag the measure “Reseller Order Count” from the list of the measures (to the left) onto the 

“Measures” designer: 
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As you see, the table has changed its view. Now it displays 2 measures “Reseller Sales 

Amount” and “Reseller Order Count” in different columns.  

You can drag the measures from columns to rows: 

 

After doing this you will get the following table: 

 

Note: the measures are displayed in rows (not in columns). 
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 Other Operations Changing the Page Structure 4.6

 Virtual Hierarchies 4.6.1

The hierarchies can be of several types: regular, attribute and parent-child: 
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In the section 3 of this document we’ve already described the types of hierarchies. Let us 

look at the table where there are more than one attribute hierarchies:  

 

Let us join all the attribute hierarchies into ohe virtual hierarchy by pressing these buttons: 
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As a result, out table will look like this:  

 

Virtual hierarchies are easily recognizable: they are highlighted with a different color.  

You also have the option to Expand / Minimize all level elements for virtual hierarchies in a 

way similar to the usual hierarchies. 

Let's, for example, minimize all the elements of the “Date\Date.Calendar” “Year” level: 
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Now the report will look as follows: 
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 Swapping Rows and Columns 4.6.2

There is a way to quickly swap rows and columns with the help of this button on the toolbar: 

 

 Data Editing (Write Back) 4.6.3

 

This mode allows to edit data in the cubes. In order to edit data it is necessary for 

administrator to allow this functionality for the user, and it is necessary to have a measure group 

that supports  the writeback mode.  

During editing data it is possible to automatically update all the other data after finishing the 

edit operation: 

 

 Removing Controls from Rows, Columns and Context 4.6.4

Each control on designers has a cross icon: 

 

By pressing it you can remove the control from the page. The corresponding dimension will 

not be displayed in the table after you delete its control.  
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 Hiding Empty Rows and Columns 4.6.5

Sometimes it happens that the whole row or column has no data. To prevent the displaying 

of empty rows and columns on the page you can select the menu items “Hide Empty Rows” and 

“Hide Empty Columns” in the “Table” menu: 
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 Grouping of Measures 4.6.6

Let us look at the report where there are several measures from one folder: 

 

There is a possibility of grouping them. In the menu “Table” select the item “Group 

Measures”: 
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As a result, the table will become as following: 

 

Grouping of measures means to display the folders as captions. Later you can rename and 

format the folders. If you click the right mouse button on the header, you will have this:  
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In the “Formatting” dialog bot we have two tabs – “Header” and “Separators”: 

 

The first tab allows to change the name and set up the format rules for the header  of the 

measure. The tab “Separators” allows to set up the size and color for rows/columns separators and 

to define the thickness and color of the lines.  
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 Size of columns/rows 4.6.7

You can set the size of columns / rows on pages of the Table type. To do this, select “Set 

Size of Columns / Rows ...” from the “Table” main menu: 

 

This submenu allows the user to specify the same width for all columns and the same height 

for all rows of the table: 
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 Description of a Page 4.6.8

For any report you can create a description using any text, used hierarchies and RTF 

formatting. 

Let us look at the example: 

 

In the “Table” menu select the “Report Page Description”: 
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In the left part there is a list of hierarchies which are used on the report page. Using the 

mouse drag some hierarchies into the text: 

 

Let us set up the height of the description field equal to 140 pixels, set up the font color and 

the font parameters: 
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In the “Report Page Description” window press  «OK». As a result, the table will contain the 

page “Report Page Description” with the following text: 
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Let us look at the way to set up description using RTF. Let us insert into the description field 

the prepared RTF text: 

 

The table will have the following description: 

 

If the RTF format is used, the formatting of the text and font is not applied. 

Tables with the description can be exported to Excel. 
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 Displaying Totals 4.6.9

In order to explain what is “Visual Totals” let us build the following report. On the rows we 

will place the “Product Categories” hierarchy with the following selection: 

 

On the columns let us place the years from the “Date.Calendar” hierarchy. Inside the table – 

the “Reseller Order Quantity” measure. You will get the following report: 
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4.6.9.1 Summary Rows and Columns 

You can add summary rows and columns to the report. These rows and columns will show 

the SUM of the elements on the topmost visible level in the report.  

In the “Table” menu select the items “Show Summary Columns” and/or “Show Summary 

Rows”: 

 

Then you will get the following report: 

 

As you may see, in the summary row there is a sum of “Bikes” and “Clothing”. 
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4.6.9.2 Visual Totals 

In the sample report (above) you can see that the row with “Clothing” there is a total of all 

kinds of clothing, but NOT just 2 selected elements (“Caps” and “Jerseys”).  

In order to see the totals for only visible elements, you have to select “Show Visual Totals” 

item in the “Table” menu: 

 

If you switch on “Show Visual Totals”, you will see this: 

 

Now in the row “Clothing” you may see summary values of ONLY two selected subitems – 

“Caps” and “Jerseys”. 
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Here is one more example of the visual totals: 

 

Let us hide one of the elements from the group “Accessories”: 
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As a result, the report will look like this: 

 

The sum of this group of goods remains unchanged. 

We’ll use the visual totals to display the real summary of the selected goods: 
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Now the report will look like this: 

 

 Operation “Show By” of the Context Menu 4.6.10

In the context menu there is an operation “Show By”. Let us look at the example. Assume 

you have a report of the following structure:  

 

Let us do the “Show By” operation in order to look the sum of sales for a specific product 

(for example, for “Road Bikes”) by all countries.  
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Select menu items Show By → Geography → Country: 

 

As a result we will have the following report: 

 

As we can see, we have a report of sales by countries. The “Product” hierarchy has come to 

the context. If you show the member selector for the context, you will see that the only one item is 

selected there – the one for which you’ve made the operation “Show By”. 
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Therefore, we are watching sales only for “Road bikes”. 

In a similar way “Show by” is working for table cells. If you perform “Show by” on the cell 

where “Road Bikes” and “CY 2007” intersect, you will get a report which displays sales in all 

countries for Road Bikes in the calendar year 2007: 

 

As you may see, the context has 2 items – “Road Bikes” and “CY 2007”: 
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 Data Refreshing on the Page 4.7

Each page has an important option – «Automatically change data when the structure is 

changed». If this option is on, after each change of the page structure the new data will be 

displayed. If this option is off, you can change the structure of the page first (data will not be 

automatically refreshed), and then you can manually refresh the data. During the time you make 

modifications the requests will not be automatically sent to the server. 

This option is switched on/off by using this button:  

 

Let’s assume we have the following page: 
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and upper mentioned option is turned off. Let’s change the page structure by dragging more 

dimensions and measures into the designers: 

 

Note: after changing page structure you see old data. This happens because the option is off. 

If we press «Refresh Data» now: 
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the data will be refreshed according to the new structure: 

 

Do not forget to switch on this option for further reading.  

There is also a possibility to «Refresh data on all pages» at once. It will take time 

dependently on the number and complexity of pages. 
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 Charting 4.8

A chart is a part of a report. It may be not displayed, displayed alone or with a table. The 

view mode of a chart can be changed on the toolbar or in the “Table / View Mode” menu: 

 

In the lower left corner you may see the chart parameters: 

 Layout: influences where the chart will be displayed – below the table or to the right of it.  

 Argument. The chart displays the data which are in the table. On the screenshot above you 

may see “Argument = Columns”. It means that the columns of the table will be placed on 

the X axis. If we change the argument on “Rows”, we would see this: 
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 Type. This parameter sets up the type of the chart. Now you see bars, which can be changed 

onto lines:  

 
 area: 

 
3D chart: 

 
and other types of chart. We propose you to make some experiments with the type of a chart 

on your own.  

 Properties. Among the properties are: “Legend” (you see it in the top right corner), “Rotate 

by 90º” and “Labels” (labels are the numeric labels which are displayed over bars or lines). 

 Settings.  
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 Chart Settings 4.8.1

If you press the button “Settings” in the bottom of the page, you will see the following form:  

 

4.8.1.1 Maximum Number of Data Items 

On the “Data” tab you may set the maximum number of items which can be displayed in the 

chart. Let us create the following example: put all the cities of the hierarchy “Geography”: 
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On the columns we will display years, the measure “Reseller Sales Amount” will be 

displayed in the table. Switch on the chart: 
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As you may see, there are 1163 elements on the chart. This is a big amount – bigger than the 

allowed number in the settings. In order to change the settings, press the button “Settings” and 

change the setting onto 1200:  
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After pressing «OK» you will see the following: 

 

Pay attention to the fact that the chart can be painted for a long time in the case if there is a 

huge number of elements on the chart. In order to avoid waiting you can set up maximum amount of 

elements, so that the chart will be painted only when the number of elements is less than the 

maximum amount.  

As you may see, when «Too much data» message is displayed, there are two available 

options: “Draw Chart” and “Change chart settings”: 

 

If you press the link “Draw chart”, the chart will be drawn but the settings will not change. 

The chart will be visible until you change the structure of the report.  
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The link “Change chart settings” does the same as the button “Settings” in the bottom left 

corner of the page – it will open the form for changing the chart settings. 

4.8.1.2 Scrolling 

Sometimes we have a situation when the X axis contains too much elements. As a result, the 

chart becomes unreadable: 

 

In order to correct the situation open the settings dialog: 
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On the tab “X-аxis” switch on the scrolling on the Х axis and set the number of elements 

equal to 20: 

 

After this action, the chart will become much more readable and you will be able to scroll it 

using the scrolling on the X axis: 
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4.8.1.3 Minimal and Maximal Values for a Chart 

There are several ways how we can set up the axis range on the Y axis: 

 Full; 

 From minimum to maximum; 

 From some [Value1] to maximum; 

 From minimum to [Value2]; 

 From [Value1] to [Value2]. 

4.8.1.4 Coloring Series  

Let us look at the example of setting the colors for chart series. Let us assume we have the 

following table with a chart: 
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Let us color the whole category Acessories and all the subcategories into green, and let us 

color “Closing” into yellow. Click the right mouse button on the series or on the item in the legend:  

\
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In this window do the following: 
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As a result we will get the following chart:  
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Let us move one level below: 

 

Each category and all elements below it now have its own color which can be changed.  
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You can also set the color for every element of a group: 
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 Settings for Displaying of Measures 4.8.2

Let us look at how several measures are displayed on a chart on the following example of a 

report:  

On the rows we have all months of the years 2006 and 2007 selected:  

 

On the columns there are “Sales Amount” and “Reseller Sales Amount”: 

 

In the context we have “Road Bikes” selected: 
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The report shows us the sales amount of road bikes by month of the years 2006 and 2007: 

 

But in case we have 2 measures displayed on the chart it is difficult to analyze how the 

reseller sales amount change. It would be nice if the summary sales are displayed by line over the 

bars. 
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Let us change the way how the “Sales Amount” is displayed. Press the button on the “Sales 

Amount” control which opens the settings for this measure, as shown on the picture: 
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Check the box “Override type” and select the line type: 

 

Press the button “Apply”. The chart now looks like this: 
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You can also display charts for different measures on different panes. In the same settings 

dialog for “Sales Amount” set the parameter “Display” equal to “On Pane 2”: 
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Press the button “Apply”. You will get the following chart: 

 

You can display each measure on one of four available panes, or you can also select «Don’t 

show» option in order to avoid displaying a measure on the chart.  

Let us look at the chart where one of the measures displays the percentage growth. Let us 

select all the months of the year 2007 on rows: 

 

Put the measures “Reseller Sales Amount” and “Reseller Sales Amount Growth%” onto 

columns: 
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Put “Road Bikes” into context: 
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Let us show how to make a separate axis for the measure “Reseller Sales Amount Growth 

%”: 
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Put it onto pane 1 (the same pane where the measure “Reseller Sales Amount” is): 
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Now let us set up the axis: 
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The chart looks like this: 

 

We have a chart with two measures at once, each measure has its own axis. 
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 Additional Possibilities of Charts 4.8.3

Since the bars (points, sectors, etc.) of the chart display values of the table, you can use the 

operations like “Drill through” and “Show by” on them. These operations are available in the 

context menu: 

 

Also you can print the chart from the context menu or save it as an image in PNG format.  



 

  

 115 

Three is a possibility to choose which levels to display on the chart. Let us look at the 

example: 

 

All levels are displayed by default. But we have a possibility to display the following 

options:  

 First Visible Level 

 Last Visible Level 

 All Levels 

For each hierarchy of the report there is a possibility to choose between:  

 Fist Visible Level 

 Last Visible Level 

 All Levels 

 By  Default 



 

  

 116 

Let us display just the years without half-years and quarters. To do this, select “First Visible 

Level” for the hierarchy “Date/Date.Calender”: 

 

As a result we’ll get the following visualization: 
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You can change the settings of the chart: 
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Here you can add the restrictions for specific hierarchies or to reset all the settings. Let us 

add the restriction and display only the quarters on the chart:  

 



 

  

 119 

As a result, we’ll get the following report: 
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5 Creation, Saving and Restoring of Pages 

 Creating a New Page 5.1

A report can have arbitrary number of pages. In order to add an empty page you have to do 

one of the following: 

1. Press the button “Add New Page” in the toolbar: 

 

2. Or select the item “Add” in the “Page” menu:  

 

After doing this you will get a dialog box which will let you input the name for a new page 

and select its type: 
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After pressing «OK» the new page will become available: 
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 Copying the Existing Page 5.2

You can create an exact copy of any page. This can be done using context menu for the 

corresponding tab: 

 

After that the application will ask you to enter the name of the new page: 

 

After pressing «ОК» the page will become available: 

 

You can also copy a page using corresponding item of “Page/Copy” menu or by pressing a 

button on the toolbar: 
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Attention! 

All the changes you perform over the structure of your own pages are saved on the server. All the 

changes you make to the administrator’s pages will be lost after you close the report. That’s why 

you should use page copying as an efficient way to save the structure you need for further viewing. 

 

 Pages Saving 5.3

If you are the author of the page than that page is marked with a blue color and when you 

move the mouse pointer over it you will see a hint «Page created by ...»: 

 

You can see four pages on the picture: first two are the administrator’s pages and the last one 

is yours. 

You can save the structure of your own pages using one of the approaches: 

1. Press “Save Report” button on the toolbar: 

 

2. Use the “Page/Save” item from the main menu. 

 

Attention! 

1) You can save only your own pages. If you perform any changes to the administrator’s pages 

and save all pages of the report, you will lose all the changes you made to administrator’s 

pages. 

2) When you are saving a report, the structure of the report is saved (the information about 

what is placed on the rows and columns etc.), but not data. It is saved on the server, so if you 

will login to the Report Module on the other computer you will see all the pages you saved. 
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 Undo Action 5.4

While working with a report sometimes you’ll need to rollback one or more previous 

changes you made, i.e. return the report to the state it was in before you made those changes. To 

perform such rollback there is an “Undo” button on the toolbar: 

 

After undoing some changes you can return them back (i.e. perform the changes once again) 

using “Redo” button: 

 

 Report Restore 5.5

There is a way to restore a pages structure. It means that all your changes on the page will be 

lost and you will get the last saved (by you or administrator) version. 

Here is an example. Suppose, the page was looking like this when you opened it: 
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You changed it structure – for example, altered the selection on rows and columns, so that 

the page now looks like this: 

 

If you wish to undo all your changes and return to the version saved on the server 

 select “Page / Rollback to last save view” from the main menu: 
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 Export of Pages and Data 5.6

 Data Export to Word, Excel, PDF. 5.6.1

To export pages data to the Word, Excel or PDF file, you’ll need to perform one of the next 

actions: 

1. Select “Table / Export to Excel” (Word or PDF) from the main menu; 

2. Press the right mouse button inside the table to call the context menu and then select “Export 

to Excel” (Word or PDF): 

 

When the export is completed you will be asked if you want to open the created file. 
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 Saving the Pages to NRP file 5.6.2

NRP is a file format developed for compact and secure report saving. There is a special NRP 

files viewer available on the pages of Business Analysis Tool portal: 

 

After downloading and installing this viewer you will be able to view NRP files, just the 

way you do it with PDF, DOC and other document files types. 

To save your page to an NRP file you need to select “Report / Save to NRP File” from the 

main menu. 
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The window will appear where you’ll be able to set some advanced saving settings: 

 

NRP file format supports the saving of multiple pages into one file. In the «Save to File» 

window you can select the page you want to save, set the compression level and set the password 

required to open a saved file. The compression level does not affect the data you are saving, it only 

affects the size of the resulting file (the bigger is compression level, the smaller will be the file 

size). If you’ll set the password for the file no one will be able to open it without the password. 
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6 Advanced Report Designing Options 

 Detailed View (Drill Through operation) 6.1

Drill through (detailed view) enables you to view the piece of data from DB that some value 

from the table is based on. 

Let’s perform the drill through operation on our example report page. Select an arbitrary cell 

from the table on which you wish to perform a detailed view. Now press the right mouse button on 

that cell and select “Drill Through” from the context menu: 
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As a result you will see first 1000 rows from the data base table: 

 

You can export those results to an Excel file. 

 

Attention! 

1) It is possible that you don’t have enough rights to perform drillthrough (if an administrator 

didn’t allow you to). In that case you won’t be able to see the corresponding menu item. 

2) The drill through operation may be not configured on the corresponding cube on the server. 

In this case trying to perform the operation you will get an appropriate message. 
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 Data Highlighting 6.2

Highlighting helps you to better analyze data. Let’s prepare the table of the next structure: 
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On the rows – “Product Categories” dimension with a whole “Product” level selected under 

the “Touring Bikes” element: 

 

on columns – years 2007 and 2008. Inside the table – “Reseller Sales Amount” measure. 

Say, we need to emphasize somehow the sales amount larger than 500,000. To do that, 

perform one of the following actions: 

1. Select “Table / Highlight” from main menu. 

2. Select the corresponding item from the context menu of the table: 
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3. Press the Highlight button at the bottom of the editor: 

 

The window will appear containing highlight rules (there are no rules at the moment): 

 

Press the Add button and a new tab with a highlight rule will appear.  
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Let’s name the rule “More than 500K” and fill in all the fields as it is shown on the picture 

below: 

 

According to the configured rule, the “Reseller Sales Amount” measure will be analyzed. 

The type of analysis is Exception (exceptional situation), empty fields will be ignored and the 

values bigger than 500,000 will be colored green. 
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After pressing «OK» button you will see that all values bigger than 500,000 are highlighted 

with a green color: 

 

You can set multiple highlight rules. 
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The highlight can also be of gradient type. Open the highlight rules window once again and 

change the highlight settings as it is shown on the picture: 

 

After that the table will look like this: 

 

  



 

  

 137 

You can easily notice that the bigger is value in the cell, the more saturated is its color. If 

you press the “Select” button in the highlight rule’s settings window,  

 

then the other window will appear where you can set the gradient settings: 

 

You can set one-color, two-color or rainbow highlight, set the number of steps, etc. 
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 Text Formatting 6.3

Apart from highlighting there exists a possibility to «paint» the text on rows, columns and 

inside the table. To do that select «Table / Formatting» in main menu or the similar item in the 

table’s context menu. The following form will appear: 
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You can do the same thing from the context menu of the table: 

 

or 
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When the user enters in menu “Formatting”, he will get a dialog box with the tree open at 

the left side. The tree will be open up to the level which was selected by the user: 
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If we use the main menu to get into this dialog box, we’ll see the following:  

 

The tab “Table” is used to set up the color of the lines. The rest two tabs are used to format 

hierarchies, levels and measures. 
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 Hierarchy Formatting 6.3.1

Each hierarchy has a set of settings for automatic coloring of its levels. Let us look at the 

example. Click the right mouse button on the hierarchy “Product/Product Categories” and select 

“Formatting”: 
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In the window below let us set up the following parameters for the level “Product 

Categories”: 
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The table will look like this:  

 

If we select the topmost level as well: 
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the table will look like this: 
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Format dialog can also be called from the context menu: 
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Let us look at one more example. Let us put the “Geography” and “Date/Date.Calendar” 

hierarchies on rows and let us put the hierarchy “Product/Product Categories” in context. Select 

“Bikes” in context:  
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If the automatic level coloring is set for hierarchy “Geography”, but is not set for hierarchy 

“Date/Date.Calendar”, we will see the following table:  

 

The format rules are going “through” another hierarchy for which they are not defined.  

If we set up the format rules for “Date/Date.Calendar” which is placed to the right side of 

“Geography”, we will get this:  
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The right formatting rule has priority over the left formatting rule. If we have several levels 

displayed in the “Date/ Date.Calendar” hierarchy, it will look like this: 
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 Formatting for Levels 6.3.2

For every level of the tab “Hierarchies” you can set up parameters of the body and the 

header. Let us look at the example:  
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Let us select the following parameters on the tab “Header”: 
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Set us “Apply header formatting to body”: 
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As a result, the table will look like this: 

 

 If we increase the height and width of cells, we’ll get a readable version:  
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The selection looks like this: 

 

 

So, the rule is next: the settings for body of the table have higher priority than setting for the 

hierarchy.  

Let us add one more level: 
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 157 
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As a result, the table will look like this: 

 

We can conclude that formatting for a specific level overrides the settings for the whole 

hierarchy. 
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 Measures Formatting 6.3.3

Let us look at measure formatting: 

 

There is one more tab “Representation” in the dialog where you can set set the number of 

digits before the decimal point, the currency symbol, the color and the font parameters for the 

measure. Let us set up the following parameters for the “Reseller Sales Amount” measure: 
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The table will look like this: 
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 Formatting for Virtual Hierarchies 6.3.4

The virtual hierarchies are accessible on the tab “Hierarchies”: 

 
Let us make an example using a virtual hierarchy with levels “Date/Date. Month” of “Year” 

and “Product/Color”: 
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Let us set the default settings for all levels:  
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The table will look like this:  
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Let us set up formatting for virtual hierarchies: 
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At the first sight this action changes nothing. But as soon as we merge two hierarchies, the 

table will look like this:  

 

As our experience shows, there is only one virtual hierarchy in most of the cases. But if there 

are two or more of them, the settings will be applied just to the most right of them.  

Example: 
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This version is more readable: 

 

 Formatting priorities 6.3.5

There are several rules:  

 Highlight rules have the biggest priority; 

 The measure body formatting have the middle priority;  

 Level formatting rules have the lowest priority.  

If there are several format rules and some of them are in rows, then the priority belongs to 

the object which is at the right side.  

If there are two hierarchies – one of them is on rows, the other one is on columns, the higher 

priority will belong to the one which is on rows.  
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 Table Separators 6.3.6

There is one more tab for levels, measures and measure headers:  the “Separators” tab. The 

tab allows to set the thickness and color for the lines and separators.  

Let us look at the example with the following selection on rows and columns:  

 

The columns have this: 
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The context contains “Bike” category, measures “Reseller Sales Amount” and “Reseller 

Gross Profit Margin” are groupped on columns. There are some formatting rules in this report: 
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Let us set up the following parameters for separators and levels:  
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Our report will now look like this: 

 

Let us move the dimension from context to columns and change the selection:  
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Then let us configure the following settings for separators: 

 

The report will look like this: 

 

 

 

Separator Priority Rules 

1) Separators of the higher level have priority over separators on the lower level.  By “higher” 

we mean the “higher visible level that is at the left on rows/columns”. 

2) At the same level the separator has higher priority over the line 
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 Using Advanced Designers 6.4

In the chapter “Change of the Page Structure” we have already reviewed the definition of a 

designer and the ways of using basic designers. Now let’s review the advanced designers: “Filter” 

and “Sorting”. Those two designers are situated near the “Rows / Columns” designer: 
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 Filter 6.4.1

“Filter” can be invoked both from the context menu of the header: 

 

and from the context menu of the tab “Filter”: 
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There are several filtering options here: 

 

 In the sections 1 – 4 there are quick filters: 

 Top 10 – 10 biggest values; 

 Top 50 – 50 biggest values; 

 Top 100 – 100 biggest values; 
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 Top Х – Х biggest values; 

 Top 80% - the biggest values whose sum is not less than 80% of the total sum; 

 Top Х% - the biggest values whose sum is not less than X% of the total sum; 

 Bottom Х – Х bottom values; 

 Bottom 20% - the lowest elements whose sum is 20% of the values; 

 Bottom Х% - the lowest elements whose sum is X% from the total sum; 

 Non-empty values – show all elements except those which have empty values; 

 Empty values or 0 – show all elements which are either empty or 0; 

  =Х – values equal to X; 

 < > Х – values not equal to X; 

 > X – values more than X; 

 >= X – values more or equal to X; 

 < X – values less than X; 

 <= X – values less or equal to X; 

 X <= value <=Y – values in the range from X to Y. 

If you select “Custom Condition…” you will get a window which allows to select the 

filtering condition and the arguments:  

 

 

The context menu in section 6 allows to switch on/off all filtering at once.  
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It is worth to look at item “Add Filter of Rows (Expert Mode)…”: 
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There will be a form for setting up a filter: 

 

 

This dialog allows not only to select the conditions for filtering and the argument, but also 

the set of columns to which it is applied: 

 All visible columns 

 Selected columns 

Besides, the condition can be met for:  

 For the sum of columns; 

 For at least one of the columns which are considered (see below); 

 For each column, of those which are considered (see below). 
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Let us look at several examples. 

Let us assume we want to show only 5 subcategories of goods which were best sold in 2007. 

Let us compile the report as on the picture below: 
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Let us invoke the context menu for the header CY 2007 and select the item “Filter / Add 

Filter of Rows (Expert Mode)…”: 
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There will be a dialog for filter settings on the screen: 
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The selected function “X topmost members (TopCount)” is exactly what we need. In the 

Columns section it is said “For the sum of columns”, but we have just one column, so the filtering 

will be done for the year of 2007.  Press «OK» and look at the report: 

 

 

There is an icon on the tab Filter that shows us that there is a new filter there. If we look at 

this tab, there is a filter with a name “Filter 1”. The table contains exactly 5 categories that are sold 

best in the year 2007. 

Let us make the task more complicated. Assume we want to see those 5 products which are 

best sold in the sum of years of 2007 and 2008. Click on this icon: 
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and do the following actions there: 

 

In this window we have to select “For the sum of columns”, then click on the member 

selector for date dimension and select CY 2007 and CY 2008 by first pressing “Refresh Children”: 
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After pressing “OK” the filed for Date dimension will look like this: 

 

This means that several members are selected. If you press “OK” the report will look like 

this: 

 

Only those product categories which are sold best by the sum of two columns will be 

displayed. 

Filters can be switched on and off: 

 

The selected check box means that the filter is switched on. If you switch it off, it will 

remain in the report configuration but the filter won’t be active, so that the rows will not be filtered. 
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Using the previous example let us set up the following parameters:  

 

The hierarchy “Date/Date.Calendar:(Multiple Selection)” contains 2007 and 2008 as before. 

We will get:  
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Here we see the OR-principle: the row will remain in table if one of the columns meets the 

condition.  

If we filter using the parameters below: 

 

We will get the following result: 

 

It is obvious that the last element was removed since it did not meet the condition by two 

years simultaneously (the AND principle). 
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Attention! 

Filters are the part of page structure. If you create filters on the administrator’s page and close the 

report, all those filters will disappear. If you wish to keep your filters, make a copy of the page 

and save it. 

 

 Sorting 6.4.2

Let’s show how to sort rows in the table on the following example report: 

 

Filters are turned off. Product subcategories are on the rows, years – on the columns. 
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Using this example report let’s sort the rows in the table in the descending order of sales in 

2007. Press the right mouse button over the CY 2007 column header: 
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Select “Add Sorting of Rows (Expert Mode)” from the context menu as shown on the 

picture above. You will get a dialog that looks like the one you were using to create the filter: 
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Note that the time is already selected correctly (that’s because we called the context menu 

for the CY 2007 element). Let’s change the sorting order to “Descending” (as in the picture) and 

leave the field “Save Hierarchy” unchecked. Press OK. You will get the table with the values in the 

CY 2007 column sorted descending: 

 

Note the “Sorting 1” sign that appeared in the “Sorting” designer on rows. You can perform 

the same actions with it as you did with the filters: activate, deactivate, edit and remove. 
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The same sorting can be created easier using one of the quick sorting options. To use it call 

the context menu for the CY 2007 element and select “Sort Descending (break hierarchy)” from it: 

 

As you could notice, there are 4 options of quick sorting available: 

 Ascending, breaking hierarchy; 

 Descending, breaking hierarchy; 

 Ascending, preserving hierarchy; 

 Descending, preserving hierarchy. 
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 Calculated Members 6.5

If you are granted with appropriate rights by an administrator then in report designer you 

will be able to create your own dimension members and measures based on the existing ones, both 

for usual reports and for “Interactive Dashboard” reports. Let’s take a deeper look at the process of 

creating calculated measures and dimension members. 

 Calculated Measures 6.5.1

You can create your own calculated measures and use them just the way you do it with 

ordinary measures. To create a new calculated measure press the right mouse button anywhere in 

the measures list. You will see the context menu, which will give you an ability to add calculated 

measures: 

 

After pressing “New Measure on Report…” or  “New Measure on Cube…” item you will 

see a wizard that will help you to create calculated measure: 
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The wizard lets you choose the type of a new calculated measure from six different options: 

 Relationship; 

 Parallel Period; 

 Growth; 

 Rolling; 

 Period to date; 

 Custom MDX; 

The last option is for experts that are familiar with MDX querying language. All other 

options will let you create new measures in an easy wizard mode. 

For example, let’s create a calculated measure of an average sales amount by orders – the 

ratio of sales amount to orders count. Select a “Relationship” measure type: 

 



 

  

 195 

Press “Next” and fill in the fields in the next window as it is shown in the picture: 

 

After pressing “Finish” you will see the folder for calculated measures in the measures list 

and it will contain a new measure: 
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Now you can use that calculated measures the same way you use the other measures. Just 

drug the new measure into the “Measures” designer and you will get the expected result: 

 

To edit or delete calculated measure just click the right mouse button on the corresponding 

measure in the list and select “Edi” or “Delete”, respectively: 

 



 

  

 197 

Besides, users can allow or forbid the shared access to the measures. Depending on who was 

the measure creator and if it was shared or not, it would be displayed using different icon:  

 

1 – a measure created by this user on a report level; 

2 – a shared measure created by this user on a cube level; 

3 – a measure created by a different user on a cube level and shared with this user; 

4 – a measure created by administrator on a cube level; 

5 – a measure created by administrator on the report level and available just for this report. 

 

6.5.1.1 Parallel Period 

In the previous chapter you created a calculated measure of “Relationship” type. In this 

chapter you will see the example of measure of “Parallel Period” type. 

For example, let’s create a measure showing the value of “Reseller Sales Amount” in the 

same month of the last year, and use this measure to compare the bikes sales in different months of 

this and previous year. 
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Add a new measure to the measures list using the corresponding context menu option: 

 

When creating a new calculated measure select “Parallel Period” measure type and press 

Next: 
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In the next window fill in all fields as it is shown in the picture: 

 

The selected Parallel period type at the bottom (Value from parallel period) means that the 

value of the measure selected in the “Base Measure” field (“Reseller Sales Amount”) will be 

shown. The Time “Hierarchy” field points to the hierarchy that will be used to count the parallel 

period. And the values in the “Level” and “Periods” fields mean that the data for a time period, that 

was 12 month before the current period, will be shown. 

After filling in all fields press «OK» and you will see a newly created measure in the 

measures list: 

 

Place the months of the year 2007 on the columns of your table: 
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Place the “Bikes” category from “Product Categories” hierarchy into the context, thus you 

will see only the sales data for bikes: 

 

After that place two measures on rows: “Reseller Saves Amount” and newly created 

“Reseller Sales Amount Parallel Period”. You will get the following report: 

 

Add a chart to your report. Set the argument to columns and remove the legend: 
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After that you will get the report like this: 

 

In the chart you can see that two bars are corresponding to every month: red one stands for 

the current “Reseller Sales Amount” value and a blue one – for the value of that measure in the 

same month of a previous year. 

6.5.1.2 Growth 

Calculated measure type “Growth” lets you create a measure that will show an absolute or 

relative growth of another measure. 

Let’s create a measure that will show a relative growth in percents of “Resellers Sales 

Amount” measure in this month comparing to the previous month, and use that measure to show the 

sales growth of bikes. 
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Add a new calculated measure of “Growth” type: 

 

In the next step fill in the fields as it is shown in the picture: 

 

“Base Measure” field points to the measure the growth of which we are interested in. The 

Time Hierarchy field is for selecting the hierarchy that will be used to count growth, in most cases 

the time hierarchy (like “Date.Calendar”) should be selected here. 
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After filling in all fields press «OK» and you will see the new calculated measure in the list: 

 

In the report from the previous chapter remove the “Reseller Sales Amount Parallel Period” 

measure from rows: 

 

Place the newly created measure “Reseller Sales Amount Growth %” instead.  

You will get the following report: 

 

In the chart for every month you can clearly observe the sales amount and its growth in 

percent comparing to the previous month. 
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6.5.1.3 Rolling Measure 

Rolling measure type is used to show an average or total value of some measure in a certain 

time period. 

For example, you can create a measure that will show an average profit for the last three 

month. To do that, create a new calculated measure of “Rolling” type: 

 

In the next window fill in the fields as it is shown in the picture: 
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The Operation type selected at the bottom (Average) means that the average value of a 

measure, set in the “Base Measure’ field, will be calculated, in our case – "Gross Profit”. Values in 

fields “Periods” and “Time Hierarchy” state that the average should be calculated over the last 3 

month in the “Date.Calendar” hierarchy. 

After filling in the fields press «OK» and you will see a new measure in a measures list: 

 

To try that new measure in practice, create a new page of the structure, described below. 

Put months of 2007 on columns: 

 

Put two measures on rows: “Gross Profit” and “Gross Profit Rolling”. 

Next, add a chart to the page and change the chart properties like this: 
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You will get a page looking like this: 

 

Profit for a current month is displayed with a red line, and the blue line shows the average 

profit for the last three consecutive months. As you can notice, the line corresponding to the 

calculated measure is more flat, it doesn’t display the sharp rises and falls of profit. It looks more 

like a tendency, because the average value of profit in three months is taken into account. 
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6.5.1.4 Period to date 

“Period to Date” calculated measure type is used to show a total or average value of some 

existing measure from the beginning of some period to the current date. 

For example, if you need to draw a chart representing the growth of total sales amount 

during a year, you can create a calculated measure, showing the total amount of sales from the 

beginning of the year to a current date. Let’s create such a measure. While creating a new measure, 

select “Period to Date” measure type: 
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Press «Next» and fill in all fields in the next window as shown: 

 

Operation type selected at the bottom defines that the total value of the measure selected in 

the “Base Measure” field (“Reseller Sales Amount” in our case) will be shown. In the “Time 

Hierarchy” field you have to select the time hierarchy. The total value will be calculated starting 

from the beginning of the corresponding period from the level set in the “Level” field. If you set the 

“Calendar Year” level, you will get the totals from the beginning of the year. 

Press «OK» and the new calculated measure will be added to the measures list: 
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Let’s create the charts of total sales growth during the year 2007 for every country outside 

the Americas. First drag the “Date.Calendar” hierarchy on columns and select all month of the year 

2007: 

 

Then drag the “Geography” hierarchy on rows and select all countries except “Canada” and 

“United States”: 

 

Drop a just created “Reseller Sales Amount Period to Date” measure inside the table. And 

put the hierarchy “Product Category” with only “Bikes” category selected into the context. 

Your page should look like this: 
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Change the view mode from table to chart, using the corresponding option from the toolbar: 

 

In Chart Properties select the columns as an argument and change the type of the chart to 

Line: 

 

You will get this kind of report with the charts of total sales growth of bikes in different 

countries: 
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 Measure Folders 6.5.2

When users create their own measures, all of them are automatically placed to “My 

Calculations” folder: 

 

Users can create their own trees of folders, but all of them will be under “My Calculations”. 

Let us look at the example with measures that we’ve just created. In order to manage folders, click 

on any place in the list of folders and select “Edit Folders” from the context menu: 
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In the window below there is a list of previously created measures. Let us add a folder 

«Folder 1» by pressing “Create”: 

  

In the window that appears, enter the folder name: 
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As a result we have a subfolder with the name «Folder 1» with no measures in it:  
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Let us move the measure “Gross Profit Rolling” in the new folder. It is necessary to capture 

the measure using the mouse and to move it to the desired folder: 
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If we click on «Folder 1», we can see  “Gross Profit Rolling” measure there: 

 

The folders can be renamed and deleted, and new subfolders can be created:  

 

If a folder is deleted and in the same time there are any measures in it, they are moved to the 

root folder:  
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 Calculated Members 6.5.3

You have the possibility to create your own dimension members, based on the existing ones. 

To add calculated members to some hierarchy you have to click with the right mouse button 

on that hierarchy in the hierarchies list. In the context menu select “Calculated Members…”: 
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After that a window will appear for managing the calculated members from the selected hierarchy: 

 

To add a new calculated member, press the button as shown in the picture above. A wizard 

will appear that will help you to create a new member: 
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In the first step you have two options: 

 Function over set; 

 Custom MDX. 

The second option is for experts familiar with MDX querying language and enables you to 

create a calculated member with a custom MDX query. 

Let’s consider the first option. If you select it and press Next you will see the following 

form: 
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Let’s build the calculated member that will show the total value of the measures for the 

years 2005 and 2006. To do that, select “Sum” in the “Function” field. In the “Measure” field leave 

the value “Current Measure” to make the summary value calculated over the currently selected 

measure. In the bottom part of the window you can see an elements tree where you can select the 

elements whose values will be counted in the sum. Select “CY 2005” and “CY 2006” as shown in 

the picture: 

 

After pressing “Finish” the new calculated element will be created: 
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Now add the hierarchy with the new element (“Date.Calendar” in our case) to your report on 

rows or columns. Open the member selector and you will see a new calculated member there: 

 

Add this element to the selection to see the result: 
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You can edit calculated members in the same management window that you used to add the 

member. There are buttons for editing and removing a member: 

 

You can also edit the calculated members from the context menu: 
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If you share the member with other people, it will be surrounded by green rectangle: 

 

Pay attention, that in the calculated members’ management window you can see only 

elements from the hierarchy for which you opened that window. To see the elements from the other 

hierarchy click the right mouse button on that hierarchy and select the item “Calculated Members”. 

Let’s edit our calculated member, so that it will show not the sum but the average value. To 

do that, select the element in the calculated members’ management window and press the Edit 

button. 

In the “Function” field change the value from “Sum” to “Average” and press «OK»: 

 



 

  

 223 

Now look at your report, it should show the average value for two selected years: 

 

This way you can create any number of calculated members in different hierarchies and use 

them in your reports.   

 Numeric parameters 6.5.4

You can create numerical parameters that allow the user to affect calculated measures, sets 

and members dynamically: 
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To create a numeric parameter, right-click anywhere in the parameter list. A pop-up menu 

appears allowing you to add a parameter: 

 

By clicking on the "New Parameter ..." menu item a wizard to create a numeric parameter 

appears: 

 

In form that opened you should fill in the following fields: 

 Name – fill in the name of the parameter; 

 Format – choose the parameter format: numeric or percentage; 

 Decimal Places – select the number of decimal places; 

 Default Value – specify the default setting; 

 Allowable Values –select all values or the value of the selected range with the ability to 

specify the step 
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 Description - You can briefly describe the essence of the parameter, if it is necessary. 

This parameter can be used in calculated measures, members and sets: 
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Let us look at the following example. For instance, we need to analyze how the margin for 

the “Bikes” subcategory changes provided that the prime cost of goods increases by 10%. 

 In order to do this, create a parameter “Product Cost”: 

 

After that, we need to create a measure for “Plan Gross Profit”, which will calculate 

predictable margins using parameter “Product Cost”: 
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Now let us create a report with the “Bikes`” subcategories on rows: 

 

In columns it is December 2007: 
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Now let us add three measures to our row: “Sales Amount”, “Gross Profit”, “Plan Gross 

Profit”. As a result, you will get the following report with parameter “Product Cost”: 
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Let us increase “Product Cost” by 10%: 

 

In this case the sales of Touring Bikes subcategory will go down. 
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 Description of calculated measures, sets and parameters 6.5.5

Similarly to numeric parameters, it is possible to specify a description for the calculated 

measures and sets (of an arbitrary MDX type): 

 

After that, when pointing at a measure, you will see the following message: 
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 Gauges 6.6

 Creating Gauges 6.6.1

In order to create a gauge, it is necessary to click on the desired measure and select the 

visualization type as a gauge: 
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There are the following types of gauges: 

 

The field “Goal” defines the measure which will be used as a target in data analysis. By 

default it is empty. If we don’t select a measure in the “Goal” field, the analysis is done relatively to 

the fact measure (in our case this is “Internet Order Quantity”). 
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Let us select the measure “Reseller Order Quantity” in the field “Goal”: 
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The next step will be to select the “Goal”: 

 

Then select the way how the label will be rendered: 

 



 

  

 235 

And set the value of  “X”: 

 

By default the application offers its own scale, but the user can override the value of the 

minimum and maximum: 
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As a result of the selected parameters we will get the visualization with the icon on a gauge 

meaning the fact (Internet Order Quantity).  In the center of the gauge there is a label which 

displays the difference between fact and the goal: 

 

As we can see on the pictures, the goal were not met in the years of  2005 and 2006.  
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There is one more type of the gauges called “Traffic lights”:  

 

Select the traffic lights in the drop down: 
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There are two kinds of visualizations for the traffic lights. In this type of the gauge the 

parameters are similar to the previous one:  we can set the “Goal” if necessary. The difference is in 

the ranges which correspond to the color of the traffic lights. 

Let us show the difference between the fact (Internet Order Quantity) and the goal (Reseller 

Order Quantity).  The negative value of % of the difference will be displayed using red color, the 

difference from 0% till 100% will be displayed using yellow color, values of more than 100% will 

be displayed with green. Let us set up the following parameters: 
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As a result, we will get the following report: 
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You can switch on or off displaying the values: 

 

Gauges can be built using two more ways: using the context menu and the toolbar. When the 

context menu is used, you can select the way of visualization:  

 

Here you can select the type of the gauge (circle, semicircle, etc.).  
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You can select the item “Visualization” from menu “Table”: 
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The dialog window “Visualization settings” will open: 

 



 

  

 243 

In this window we have to select the fact measure, and then in the right part of the window 

select the type, goal and other parameters:  

 

 Export of Gauges 6.6.2

The gauges can be exported to NRP, PDF and Excel. While exporting to Excel the gauges 

are not exported: the cells of Excel table will contain the numbers instead of the gauges.  
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 Other Report Page Types 6.7

Apart from the pages of the table/chart form, you have the possibility to add to your report 

two more types of pages: Treemap, Scatter-diagram, Map and Dashboard. Those two types of pages 

allow you to perform advanced visual data analysis. Let’s review those two types of pages in more 

details. 

 Treemap 6.8

To add a Treemap page to your report press the “Add new page” button on the toolbar: 

 

In the appeared dialog select the “Treemap” page type and fill in the name of a new page: 

 

Press «OK» and an empty treemap-page will be created. 
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 Designers 6.8.1

We can divide the treemap-page into a number of zones: 

 

Dimensions and measures are marked in red; they can be dragged into designers that are 

marked in blue and green. 

The designers marked in blue are those where you can drag dimension members. At the top 

you can see “Levels” designer, you can drag the levels there and select the elements you would like 

to see in the diagram. Below it at the left you can see the Context designer, it works just the same 

way it did in the table page – it bounds the data shown in the report. You can drag hierarchies there. 

The designers where you can drag the measures are marked in green. There are three of 

them: 

 Size – determines the measure from which the areas of rectangles on the diagram 

will depend; 

 Color – determines the measure from which the colors of rectangles will depend; 

 Text – determines the measures the values of which will be written inside the 

rectangles in the diagram. 
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 Building a Report 6.8.2

To understand how the treemap page works and what it displays, let’s build an example 

report. 

Into the Levels designer drag the levels “Product.Category” and “Product.Subcategory”. 

You will get a diagram constructed of the same number of rectangles as the number of elements in 

the “Subcategory” level: 
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Move the grouping pointer to the right to group up the elements by product categories: 
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As you can see all the rectangles are grouped by categories. But all the rectangles still have 

the same area because we did not set the measure determining the area of elements. Drag the 

“Reseller Gross Profit” measure into the “Size” designer: 

 

Now the area of each rectangle became proportional to the corresponding value of “Reseller 

Gross Profit” measure for the element. Negative values are hatched. 
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Drag the measure “Reseller Gross Profit Margin” into the “Color” designer: 

 

The two colored gradient highlighting will be added, that will show us how large (more 

green color) or small (closer to red) is the profit from selling the products of each category. 

You can change the highlight rule by pressing the button that is showing the gradient: 
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The window for setting up the gradient will appear, exactly the same as you could see when 

setting up the gradient for highlighting in the table: 

 

And finally, using “Context” designer, let’s bound the data to show only the sales in the 

territory of “United States”. For that purpose, add the “Geography” hierarchy into the context and 

select only the element “United States” there: 
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Thus we created the report, showing the profit from selling products of different categories 

in “United States”. Every product subcategory is shown with the rectangle on the diagram. The area 

of each rectangle is proportional to the value of gross profit from selling the products of 

corresponding subcategories. And the color of a rectangle depends on the value of that profit in 

percents. The closer color is to green the bigger is the value, while closer to red, means the value is 

smaller: 
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 Navigation on the Page 6.8.3

You can perform the navigation on the treemap-page and change the page using the options 

from context menu: 

 

You should be already familiar with all these options from the description of the page of 

Table/Chart type. They do exactly the same thing as the options of the context menu called for the 

rows or columns headers in the table. 
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For example let’s use some of the available options for navigation. Let’s hide all elements 

that are not contained in the “Bikes” product group. To do that click the right mouse button on the 

“Bikes” group header and select the option “Hide Siblings”: 
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You will get the following report: 
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And now let’s find out which bikes from the “Mountain Bikes” group bring more and which 

bring less profit. To do that, you have to select all elements from the lower level under the 

“Mountain Bikes” element. To do exactly that action “Drill Down” operation is available: 
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Here is the expected result: 

 

We could also perform a “Drill Down” not only for the single element “Mountain Bikes”, 

but for all the selected elements together. To do that you have to press the plus button near the 

element corresponding to “Subcategory” level in the “Levels” designer: 
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Then you would get the diagram, showing all the products under the selected subcategories, 

all bikes in our case: 
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 Diagram Export 6.8.4

The treemap-diagram can be exported to NRP, PDF and PNG. To do that, select the required 

option from the context menu or from the Treemap main menu: 

 

After that you have to select the place where to store the file and the name of that file. 
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 Scatter-diagram 6.9

To add a scatter diagram to your report press the “Add new page” button on the toolbar: 

 

In the appeared dialog select the Scatter-diagram page type and fill in the name of a new 

page: 

 

Press «OK» and an empty scatter-diagram will appear. 
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 Designers 6.9.1

Scatter-diagram has the following structure: 

 

At the left side dimensions and measures are marked in red. The designers are marked in 

blue. 

Here is the set of designers available in the scatter-diagram: 

1. Pages designer. Here you can drop the selection of elements from one level. Every page of 

the diagram corresponds to one element. 

2. Context designer. It does the same thing as the corresponding designer in the table and 

treemap pages, bounds the data shown in the report. 

3. Details designer. Here you can drop the elements that will be shown as circles in the 

diagram. 

4. Color designer. Determines the color of the circles in the diagram. 

5. Size designer. Determines the sizes of the circles in the diagram. 

6. X axis designer. Determines the measure, the values of which will be put on the X axis. 

7. Y axis designer. Determines the measure, the values of which will be put on the Y axis. 

Thus on the scatter-diagram you can simultaneously track the changes of four measures: on 

both axes, by color and size. 
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 Building the Report 6.9.2

Let’s build the report that will show the values of “Reseller Sales Amount” and “Reseller 

Gross Profit Margin” for product subcategories sold in Australia. To do that, drop the “Reseller 

Sales Amount” measure on X axis, and “Reseller Gross Profit Margin” – on Y axis. To the 

“Details” designer drag the “Subcategory” level from the” Product Categories” hierarchy: 
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Drop the “Geography” hierarchy into the context and select the element Australia there: 
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You will get the following report: 

 

Every circle on the diagram corresponds to the element from the selection made in Details 

designer, in our case it corresponds to one product subcategory. If you drag the mouse over the 

circle, you’ll see the hint, showing, which element this circle corresponds to. On the axes you can 

see the values corresponding to the selected element. 
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 Color Designer 6.9.3

Using the Color designer you can determine on what colors of the circles on the diagram 

will be dependent. 

You can drop into the Color designer the level, used in details or one of its parent levels. For 

example, drop the “Product. Category” level into the Color designer and the products from different 

categories will be colored with different colors: 
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Also you can drop a measure into the Color designer, and then the color of the circle will be 

dependent on the value of that measure for the corresponding element. Remove the level 

“Product.Category” from “Color” designer and add the measure “Reseller Gross Profit Margin” 

there. You will see how the color of the circles changes from the bottom to the top corresponding to 

the colors of three-colored rainbow. You can change the gradient type by pressing the 

corresponding button, the same way you did it in the treemap-diagram or in the table: 
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 Size Designer 6.9.4

Using the “Size” designer you can set the measure, the values of which for every element 

will determine the size of the corresponding circle. 

Drag the “Reseller Freight Cost” measure into the “Size” designer: 

 

As you can see, the sizes of different circles became consistent with the values of freight 

cost. 

You can adjust the sizes of the circles on the diagram by setting the range of sizes in the 

“Size” designer. The smallest and the largest circle sizes can be set using the special control: 
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Also you can make the dependency of the size from the measure value reversed by checking 

the “Reverse” option: 
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 Logarithmic Axes 6.9.5

Often you can end up with the case when there is a set of elements on the diagram with very 

small values on one of the axes in comparison with the values of other elements. In such case the 

circles corresponding to those elements are situated very closely to each other and drown one over 

another, and that fact makes the analysis of such diagram very complicated. Here is a great example 

of such case: 

 

To be able to see the relative positions of circles situated closely to the minimal coordinate 

you can change the corresponding axis type to logarithmic. Then the coordinates on that axis will be 

changing not linearly but exponentially. 
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In the example report turn on the logarithmic mode on the “X” axis: 

 

Now you can clearly see different elements. Pay attention to the scale on the “X” axis, the 

values are changing exponentially but not linearly, as they used to. 
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 Pages Designer 6.9.6

In the upper part of the report page you can see the Pages designer. You can drop there the 

selection of elements from some level and analyze the data page by page. Every page corresponds 

to one element from the selection and shows the data bounded by that element. 

Add the “Month” level from “Date.Calendar” hierarchy to the “Pages” designer. Then open 

the member selector and select the following set of elements: 
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Press «OK» and you will see the following diagram: 

 

Now press “Play” button and you will see how the circles began to move and one page is 

changing another: 

 

To stop the pages changing press the “Stop” button: 

 

You can adjust the speed of changing the pages: 

 

Also you can change the pages manually, using next/previous buttons: 
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or selecting the page from the list: 

 

or using the scroll bar: 

 

 Selection on Scatter-diagram 6.9.7

Next to the “Structure” tab, where the designers are, you can find the “Selection” tab: 
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On this tab you can select some elements or groups of elements in the diagram. For example, 

select “Bikes” category: 

 

As you can see, the circles from that category are drawn brightly. At the same time, the other 

elements are half transparent. The level of transparency of other elements can be adjusted using a 

special scroll bar: 

 



 

  

 274 

Before selecting the groups you can change the grouping level from the list: 

 

You also have the possibility to select separate elements (circles) at the diagram. You can do 

that by simply clicking your mouse on the circle. Also you can select the elements from the list. 

Select the Bikes group and under the list of all elements check the “From selected groups” 

box, so you could see only the elements from selected groups (only bikes): 
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Now among the elements from the “Bikes” category select the element “Touring Bikes”. 

You will see the hint appearing over that element: 

 

You can turn off the hints by unselecting the option “Show hints”. 
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After you selected the element, press “Play” button. You will see the pages changing, but the 

trail is left after the selected element: 

 

You can clear the trails using the “Remove” trail button: 

 

Or you can turn off the drawing of trails at all by unchecking the “Trail” option: 
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This way you can select multiple elements and follow their movements on the diagram 

during the changing of pages: 
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 Context Menu of the Diagram 6.9.8

If you press the right mouse button on any of the circles in the scatter-diagram then you will 

see the context menu with a set of operations, which can be used for page navigation, changing the 

page, printing or exporting: 

 

The set of operations in the context menu is the same as in a treemap-diagram or table 

headers menus. Therefore there is no need to describe them once again. If you’ll have any 

questions, please refer to the descriptions of the corresponding operations in the chapters dedicated 

to table and treemap-diagram. 
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  Map 6.10

To add a map to your report press the “Add new page” button on the toolbar: 

 

In the appeared dialog select the Map page type and fill in the name of a new page: 

 

Press «OK» and an empty map will appear. 
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 Designers 6.10.1

Map has the following structure: 

 

At the left side dimensions and measures are marked in red. The designers are marked in 

blue. 

Here is the set of designers available in the map: 

1. Context designer. It does the same thing as the corresponding designer in the table and 

treemap pages, bounds the data shown in the report. 

2. Items designer. Here you can drop the hierarchy of geography. 

3. Latitude/Longitude designer. Latitude / Longitude measures, which are specified on a cube 

and correspond to the geographical coordinates of the selected geography hierarchy. 

4. Color designer. Determines the color of the circles in the map. 

5. Size designer. Determines the sizes of the circles in the map. 
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 Building the Report 6.10.2

Let's build the report that will show those cities of the United Kingdom, where the value of 

the Reseller Sales Amount measure for all products in 2018 is more than 100 thousand. To do that, 

drop the “Geography / Country” to the context designer and select “United Kingdom”, then drag in 

the context designer “Date / Date.Calendar Year” and select 2018. In the item designer, drop the 

“City”. To the “Latitude/Llongitude” drag “Latitude” and “Longitude ” measures, “Reseller Sales 

Amount” measure drop in the color designer: 
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Now let's create a filter that displays only cities on the map, for which the value of the 

“Reseller Sales Amount” is more than 100 thousand. To do this, add the following filter in the 

“City” hierarchy: 
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After that you will see the following: 

 



 

  

 284 

 Map types 6.10.3

There are two types of map: 

 Bubble 

We have built this type of maps with you earlier: 
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 Pie 
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Let's display the “Reseller Order Count” measure for product categories for the map 

displayed above. To do this, drag the “Category” hierarchy into the “Items” designer, and drop the 

“Reseller Order Count” measure into the “Size” designer: 
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 Color Designer 6.10.4

Using the Color designer for Bubble type maps you can use the gradient to set the color of 

the circles on the map 
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You can change the highlight rule by pressing the button that is showing the gradient: 

 

The window for setting up the gradient will appear, exactly the same as you could see when 

setting up the gradient for highlighting in the table: 
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 Size Designer 6.10.5

Using the “Size” designer you can set the measure, the values of which for every element 

will determine the size of the corresponding circle. 

Let's go for the Bubble card, which we created earlier  drag the “Reseller Order Count” 

measure into the “Size” designer: 

 

You can adjust the sizes of the circles on the diagram by setting the range of sizes in the 

“Size” designer. The smallest and the largest circle sizes can be set using the special control: 
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Also you can make the dependency of the size from the measure value reversed by checking 

the “Reverse” option: 
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 Labels 6.10.6

To display the labels of elements on the map, click on the “Show labels” button: 
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Pie maps allow you to display the values of labels of one or more elements on the map. To 

display the values of several labels, use the Ctrl + mouse combination: 
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 Legend 6.10.7

For Pie maps, you can to display or not to display a legend: 
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 Kinds for map 6.10.8

The following kinds for map are available to you: 

 

 Basic 
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 Cyclemap 

 

 Hot 
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 GrayScale 

 

 Transport 
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 Context Menu of the Map 6.10.9

If you press the right mouse button on any of the circles in the map then you will see the 

context menu with a set of operations, which can be used for page navigation, changing the page, 

printing or exporting: 

 

The set of operations in the context menu is the same as in a treemap-diagram or table 

headers menus. Therefore there is no need to describe them once again. If you’ll have any 

questions, please refer to the descriptions of the corresponding operations in the chapters dedicated 

to table and treemap-diagram. 



 

  

 298 

 Dashboard 6.11

Dashboard is a kind of a page which allows to display several components: tables, treemaps, 

scatter diagrams, maps. In order to add a dashboard to your report, press “Add new page” on your 

toolbar: 

 

In the window below select the type “Dashboard” and enter its name: 

 

Press «OK» and you will have an empty dashboard on your screen. 
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 Designers 6.11.1

The structure of the dashboard is as following: 

 

On the left side you can see dimensions and measures (marked with red rectangle). The 

editors are shown with blue rectangle: 

1. Context editor does the same thing that the similar designer in the table, treemap. scatter 

diagram and map: it sets the context for all components of the dashboard. 

2. Page editor: allows to set up the contents of the dashboard. 

 

 Building a Dashboard 6.11.2

There are two ways of how to build the dashboard: 

1. You can add new elements to it 
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Select the necessary type of the object anf drag&drop to the dashboard area: 

 

As a result you will get a familiar window where the table is already selected: 
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After you press «OK» you will have the table designer opened. Construct the following 

report: 

 

Save and close it:  
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As a result, on the dashboard page you will see the constructed table: 
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When we add objects to a dashboard, we can set up their future position. Let us add a 

treemap on the dashboard:  

 

The area marked with yellow shows that the treemap will be located exactly in that area: 
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2. You can create new Dashboard objects using existing pages: 

Select “Existing Page” as shown below and drop it on the dashboard area:  

 

In the next dialog select one of existing pages: 
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We’ll get the following dashboard:  
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One after another let us add a treemap and a scatter. After that we’ll get this:  
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 Navigation on the Dashboard 6.11.3

You can perform navigation on the dashboard and change it using the context menu:  

 

All these options of the context menu were earlier described in this manual. 
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You can edit every component of the dashboard separately by pressing the following button 

: 
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There is a context menu with the “Edit” item on the header of the component: 

 

This context menu has a set of other actions, for example “Make Multiple Copies”. Let us 

look more closely at this action.  
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Let us assume that we’re interested in getting sales by days of the week. Let us edit the 

following component: 

 

In the designer for this component put the “Date.Day of Week” into context and select the 

first day of the week:  
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As a result we’ll get the following report: 
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Save this component and close it. Now let us create several components based on that: 

 

In the member selector window select all the rest days of the week: 
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As a result we’ll get this warning: 

 

Pressing «Yes» will add a scrolling to the dashboard. The dashboard will look like this: 
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 Exporting a Dashboard 6.11.4

You can save the dashboard as a picture in PNG format. Select the menu item “Export to 

PNG…” from the context menu or from the main menu “Dashboard”: 

 

After that you have to select the file on the disk. You will get the image of the dashboard.  
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 Shared Pages 6.12

All the pages created by administrators, this user and other users have different icons:  
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Users can share their pages with other users. In order to share a page, press the right mouse 

button on the page and select the appropriate menu item.  Other users and administrators will see 

this page with green icon: 

 

 

If you click in the “Search” bar, you will be able to see who is the owner of the page:  
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Let us look at the example of sharing a page. User John opens a report. He opens the context 

menu and selects “Share”: 

 

The page will look like this: 
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When the user Mike opens the same report, he will see this: 

 

Shared access can be removed at any time by choosing the “Cancel Sharing” menu item: 

 

You can select which type of the pages to look at: 
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7 Broadcasting Reports by Mail 
After you create your report in BAT you will have the ability to set up the automatic 

broadcasting of those reports to the users’ e-mails. Users will receive the reports in the special NRP 

format. 

 NRP files 7.1

NRP is the file format, developed for compact and safe storing of reports. There is a special 

NRP-files viewer, which you can find at the Business Analysis Tool web portal: 

 

After downloading and installing the viewer you will be able to view NRP-files the same 

way as you do it with PDF, DOC and other types of files. 
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 Setting Up the Mail Broadcast 7.2

Switch to the “List” tab and select the report for which you would like to set up a mail 

broadcast. Now press the “New Report Broadcast” button: 
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A form for mail broadcast settings will appear: 

 

 

On the tab “General” you can select the status of the mail broadcast (you can change it later 

if necessary), assign a name to this broadcast, choose the language of the cube or to use the report 

name instead, and to add the notes.  
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On the tab “Periods” use the section “Mode” to select one of the scheduling modes: 

 

In the section “Properties” set up the date and periods. In the lower left zone there is a 

possibility to set up the desired time, or to set up “send every N hours”. Also there is a possibility to 

set up the end date of the mail broadcast. In the right part of the window there is a description that 

tells about when the mail broadcast will be working and what is the first date and time when it will 

run. 

On the tab “Format” you will have to select the file type that will be sent: 
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The tab “Pages” is used to select the set of pages that will be sent to the user: 
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There exist three types of pages: administrator pages, user pages and shared pages. It is 

possible to set up the desired type of page and to select the specific pages: 

 

In the edit box “Search” there is a way to quickly select the pages by name: 
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The tab “Condition” allows to set up optional condition that will be checked to decide if to 

send the mail or not to send:  

 

By default there are no conditions. It means that the mail broadcast will work always.  

But you can change it here: 

 

 Unconditional: the report will be sent always; 

 Conditional:  the report will be sent only if the condition is met. 



 

  

 326 

If you selected “Conditional”, you have to set up the condition using one of the ways: 

 

 MDX: you can write an arbitrary MDX by pressing the button “Create” 
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  you can create a new page or to use an existing page. If you create a new page, the 

window for page type selection will appear:  

 
 

In the case if you select an existing page, there will be another window: 

 

In both cases a new designer form will be open.  

Then you have to define how the condition is checked. There are 4 ways: 

 Query should return at least one cell; 

 Query should not return any cells; 

 Query should return at least one member on rows/columns; 

 Query should not return any members on rows/columns. 
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The report will be sent only in the case if the condition is met. 

Administrator also has a choice to select the user context under which the test will be 

performed: 

 Current user: the check will be made in the context of the user for whom the report 

is generated; 

 Administrator: the check is performed in context of administrator. 

 

 

 

 

 

 

Let us set up the schedule so that all users will get a report «Report 1» on the first and third 

Monday of May every 2 hours till 6pm in NRP format, including just pages «Table 1».  To achieve 

this goal, fill in the forms as shown: 

 

Note: to make sure the user gets the report by mail, their e-mail should be specified.  

Report module users also have a possibility to create mail broadcasts. But for the report 

users there are some restrictions: they can create mail broadcasts only for themselves, but 

not for other users. Therefore the tab “Users” is not shown for the users.  
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The tab “Periods”: 
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Select NRP on the tab “Format”. Select the necessary pages on the “Pages” tab: 
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The tab “Condition” should be like this: 

 

After pressing «OK» you will get a new record in the list of mail broadcasts:  

 

Let us assume we need to get the report “Sales Loss” only in the case if the loss had place. 

We want to make so that this report comes by mail every first day of every month at 

10:00am, but only in the case if the sales of  “Bikes” decreased in France in comparison with the 

previous month. If the sales did not decrease, it is not necessary to send the report.  
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To implement this task let us fill in the tab “General”: 

 

On the tab “Periods” set the following parameters:  
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Select NRP on the tab “Format”. Select the necessary pages on the the tab “Pages”: 

 

Select “Conditional” on the tab “Condition”: 
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Now we have a goal – to set up the condition “if the sales decreased in comparison with the 

previous month, then send the report, otherwise don’t send”. 

The condition will be implemented using a regular table (like in regular reports). This table 

will contain a filter which checks the loss of sales. If the table returns at least one row, it means that 

the condition is met and the report should be sent. 

Let us show how this should be set up: 

 

In the page designer let us select the following data: 
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To set up the date it is preferable to use the “floating period”: 

 

The rows contain the “Bikes” category, the columns contain France. The date is in context.    
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Let us set up the filter: 

 

 

 

This filter will return a row only in the case if the sales of bikes in the last month decreased 

in one of the countries in comparison to the previous month. Then let us save and close the page. 
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In the schedule settings in “What test to do” we have to select “Query should return at least 

one cell” (we know that the report will return data only in the case if there is a loss of sales): 

 

After you press «OK» the list of mail broadcasts will have a new record: 
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8 «Interactive Dashboard» report  
Dashboard is a type of a report with the following components: “Pivot”, “Grid”, “Chart”, 

“Scatter Chart”, “Pies”, “Gauges”, “Cards”, “Treemap”, “Filter Elements”, “Images”, “Text Box”, 

“Group”.  

Upon starting a program, a dashboard-type report appears in reports tree.  

 

Note: this one must be created by administrator. 
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When the report type «Interactive Dashboard» is opened, the following window appears: 

 
 

The list of all the reports will be shown on the left: 

 Admin’s – reports created by administrator 

 My – owner’s reports 

 Shared – reports shared with other users. 

 

Dashboard elements themselves are shown on the right. 

As we can see, there is no My Dashboards list. Let us create an «Interactive Dashboard». 
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 How to create an «Interactive Dashboard» 8.1

There are several ways to create an «Interactive Dashboard»: 

 

Way 1. In a “Dashboard” menu choose “Add”. 

Way 2. Click “Add new Dashboard” button in a toolbar. 

A window appears, where you should write a name for the «Interactive Dashboard»: 
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As a result, a dashboard designer window will appear: 
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 Basic dashboard navigation  8.2

We will take a previously-created dashboard as an example of navigation: 

 

A toolbar with dashboard elements is located in the upper part of the window: 

 Pivot 

 Grid 

 Chart 

 Scatter Chart 

 Pies 

 Gauges 

 Cards 

 Treemap 

 Range Filter 

 Filter Elements 

 Images 

 Text Box 

 Group 

The following functionality is available for dashboard elements: 

 Title 

 Currency 

 Edit Colors 

 Parameters 
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In the left part of the window there is a data source (OLAP DB) with respective hierarchies, 

dimensions. One dashboard can have several data sources: 

  

Note: In order for a dashboard to have several data sources you should contact an 

administrator. 

 

 Dashboard elements 8.3

Dashboard designer window consists of following elements: 

 Pivot 

 Grid 

 Chart 

 Scatter Chart 

 Pies 

 Gauges 

 Cards 

 Treemap 

 Range Filter 

 Filter Elements 

 Images 

 Text Box 

 Group 

 Create, delete, convert to, duplicate and other possibilities 8.4

 Create 8.4.1

In order to create a new dashboard element, you need to click a respective icon in dashboard 

designer window: 
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 Delete 8.4.2

In order to delete a dashboard element, you need to click an icon in a toolbar: 

 

In order to quickly delete all the filled fields of one of a dashboard element (grid, chart, etc.) 

you need to click an icon: 

 

 Convert To 8.4.3

It is possible to modify one dashboard element into another by choosing a respective item in 

the toolbar: 

 

 Duplicate 8.4.4

In order to duplicate an existing dashboard element, you need to click an icon in a toolbar: 
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 Transpose 8.4.5

For such dashboard element as pivot, chart, scatter chart, pie there is a possibility to 

transpose lines and columns for a grid, parameters and sets of diagrams, axes “X” and “Y” of a 

chart: 

 

 Pivot 8.5

Pivot is a multidimensional array of data.  

Let us take a “Pivot” that shows volume of sales and profit by product category in each 

country as an example. For this we choose “Pivot” in the toolbar, in the value field we will have  

“Reseller Sales Amount” and “Reseller Gross Profit” measures, on the rows of the “Country” and 

“Category” hierarchy. The pivot will look the following: 
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 Expand/minimize  8.5.1

By clicking  and  buttons, you can expand/collapse the data to the desired level. 

 Layout type 8.5.2

The Pivot layout can be: 

 Compact 

 

 Tabular 

 



 

  

 347 

Use the “Layout” button in the “Design” ribbon tab to change the Pivot layout: 

 

 Totals 8.5.3

You can control the visibility of totals and grand totals for the entire Pivot dashboard item: 

 

 Initial state 8.5.4

“Initial State” of a pivot may be the following: 

 

 Expand Column Groups 

 Expand Row Groups 
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By ticking this functionality box, we will always see an expanded level: 
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 Grand Totals 8.5.5

In the pivot table, you can enable or disable grand totals: 

 

 Totals 8.5.6

For the pivot of the tabular type (s. 8.5.2), you can enable and disable totals for the highest 

level: 

 

For instance, the image below displays the Pivot dashboard item with the disabled row 

totals: 
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Moreover, you can control the visibility of totals for individual dimensions/measures by 

using the data item's context menu (“Show Totals” and “Show Grand Totals” options): 
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 Totals Position 8.5.7

If necessary, you can change the Pivot dashboard item’s totals/grand totals position: 

            

     

 Values Position 8.5.8

The Pivot dashboard item allows you to control the position of headers used to arrange 

summary values corresponding to different measures: 
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 Filter 8.5.9

In the tab “Data” it is possible to create a quick filter for the whole pivot. It could be done in 

two ways: 

Way 1. Click “Edit Filter” button in “Data” tab in dashboard design window. 

 

Way 2. Open context menu (click the right mouse button) at any place of a pivot. 

 



 

  

 353 

Only those hierarchies, which are present in the report, may be a filter for a Pivot: 

 

Let us display, for instance, values “Reseller Sales Amount” and “Reseller Gross Profit” for 

product categories “Bikes” and “Clothing”: 
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Pivot will look the following: 

 

 Format 8.5.10

In order to change the format of a calculating value, you need to open context menu: 
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A numeric-format form will open: 

 

The form contains following fields: 

 Format type – format type may be: 

 

 Unit – Date and currency format type may have the following presentation: 

 

 Precision – number of symbols after comma; 

 Currency – currency will use toolbar parameters by default (interface language), or 

you could choose specific currency type from a dropdown list; 

 Culture – reference culture for a region should be specified; 

 Include group separator – turn a space on/off. 
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 Formatting 8.5.11

Upon opening value context menu, it is possible to create a formatting rule (highlighting): 

 

In abstract 8.18 a process of creation of formatting rules is described in more details. 

 Title 8.5.12

Before saving a created pivot let us rename its title. 

This may be done in two ways: 

Way 1. In “Design” tab press “Edit Names” icon. 
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Way 2. Open context menu in a pivot (click the right mouse button) and choose “Edit 

Names” from the list. 

 

In an appeared form enter the following data: 
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 Now a pivot title looks the following: 

 

If needed, title may not be displayed: 

 

Before closing a pivot should be saved by clicking a “Save” icon in the toolbar: 

 

Or an application will offer to save a pivot itself: 

 



 

  

 359 

A new dashboard element — a pivot Reseller will be the result: 

 

For next dashboard element editing it is needed to click an “Edit” icon in the toolbar: 
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 Export 8.5.13

If needed you can export a pivot into PDF, Excel or a picture format by clicking the right 

mouse button in a pivot: 
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 Export To PDF 

The following options are available when exporting the Pivot dashboard item to a PDF: 

 

 Page Layout – page orientation; 

 Size – page size; 

 Show Title – to display or not to display page title; 

 Title – name of page title; 

 Print Headers on Every Page – to print or not to print a title on every page; 

 Scale Mode – zoom mode; 

 Scale Factor – specifies the scale factor (in fractions of 1) by which a 

dashboard is scaled; 

 Auto Fit Page Count – specifies the number of horizontal/vertical pages 

spanning the total width/height of a dashboard; 

 Include Filters / Parameters – allows you to include master filter values / 

parameter values to the exported document; 

 Position – specifies the position of the master filter and parameter values in 

the exported document. 
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 Export To Excel 

While exporting into Excel the following options are available: 

 

 Excel Format – xlsx, xls, csv formats; 

 Separator – specifies the string used to separate values in the exported CSV 

document; 

 Include Filters / Parameters – allows you to include master filter values / 

parameter values to the exported document; 

 Position – specifies the position of the master filter and parameter values in 

the exported document. 

 

 Export to Image. 

            While exporting into a picture format the following options are available: 

  

 Image Format – PNG, JPEG, GIF formats; 

 Show Title – specifies the image format in which the dashboard item is 

exported; 

 Title – name of a pivot title; 

 Resolution(dpi) – specifies the resolution (in dpi) used to export a dashboard; 

 Include Filters / Parameters – allows you to include master filter values / 

parameter values to the exported document. 
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 Grid 8.6

Let us add a new element Grid to an already-existing dashboard.  

For this we first click an “Edit” icon on a dashboard toolbar, and then in a dashboard design 

window click a “Grid” button: 

 

Let us look at the grid, which will display the results of sales by product categories. In the 

column move a “Category dimension and a “Reseller Sales Amount” measure: 

 

 Column type 8.6.1

Columns in a grid may be of the following type: 
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 Dimension – a column shows DB dimension; 

 Measure – a column shows measure value; 

 Delta – a column, which shows a delta of two measures, where one is an actual and 

the other – a target; 

 Sparkline – a chart, which shown a measure value in a given interval (date and time); 

 Hyperlink – a hyperlink column allows you to display hyperlinks in the Grid 

dashboard item; 

 Auto – a column type is defined automatically. 

 Delta column 8.6.2

Let us create a column of a “Delta” type. Choose the type and click an «ОК» button: 
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In a column field two new fields – “Actual” and “Target” appear. Let’s choose a “Internet 

Order Quantity” measure for real values (actual), and a “Reseller Order Quantity” measure will be a 

target. We will get a new column, which will show a delta value and its indicator: 

 

A delta value type may be the following: 

 

 Actual value – an actual measure value; 

 Absolute variation – difference between an actual and a target; 

 Percent variation – percent of difference between an actual and a target; 

 Percent of target – percent of an actual and a target. 
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An indicator may have the following value: 

 

 Greater is good – «good» a target is achieved (an actual is bigger than a target); 

 Less is good – «bad» a goal is not achieved (an actual is less than a target); 

 Warning if greater – a target is bigger than an actual; 

 Warning if less – a target is less than an actual; 

 No indication – indication is not displayed. 

For the delta, you can set the threshold value, which will indicate the excess of the actual 

above the target. 
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The threshold can be of the following type: 

 

Let's get back to our grid and see if the target is achieved as a percentage. For this, let’s fill 

out the form as follows: 
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As a result, we will see a delta column in which all the values exceeding the target are 

highlighted with a green indicator, and the red values are those that have not reached a target: 

  

Obviously, the target was achieved only for “Accessories” category.  

The delta value can be displayed not only as text, but also as a diagram: 

 

 



 

  

 369 

 Sparkline Column 8.6.3

Let's create a column of a “Sparkline” type. For this, let’s consider how the quantity of 

orders for product categories changed depending on the month of the year. For this, we will insert 

the “Reseller Order Count” measure in the columns and select the “Sparkline” column type: 

 

The following settings will be available in the opened form: 

 Show start/end values – species whether or not to display sparkline start/end values 

within a grid cell; 

 Sparkline view type: 

 Line 

 Area  

 Bar 

 Win/Loss – a column-type graph (of the same size) with a Win (maximum 

value) mark and a Loss (minimum value) mark. 

 Highlight min/max points  

 Highlight start/end points. 
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Fill out the form in the following way: 

 

Then in the “Sparkline” field, drag the “Month of Year” dimension. As a result, we get the 

following report: 
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The following data is displayed in the sparkline column: 

 

 Hyperlink column 8.6.4

A hyperlink column allows you to display hyperlinks in the Grid dashboard item. 

You can provide hyperlinks as a separate data column or they can be automatically created 

at run-time from any column using the specified URI pattern. 

8.6.4.1 Data Field Containing Uri Values 

For example, take the data source of type excel-table, which contains the following fields: 
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Now let's create a table and fill it with the following data: 

 

The Grid displays column values as clickable hyperlinks allowing you to navigate to the 

Wiki's pages: 

 

You can bind the display value and URI value to different data fields. Click the “New 

Column” data item placeholder: 
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and change its type to “Hyperlink”: 

 
Drag and drop the “OfficialName” field to the display value data item placeholder to display 

official country names. Drag and drop the “Link” field to the Uri data item placeholder to specify 

URIs. 

The Grid displays official country names with links obtained from the Link data source 

field: 
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8.6.4.2 URI 

In this case, a specified URI pattern is used to generate links. 

Create the following grid: 

 

Click the “Column Type” indicator button next to the “Name” data item and change its type 

to “Hyperlink”. Specify the URI Pattern option as follows:  https://en.wikipedia.org/wiki/{0} 

 

The {0} placeholder is replaced with the “Name” data item value. The links are generated 

for country names and displayed in the grid as illustrated in the following picture: 

 

https://devexpress.github.io/dotnet-eud/dashboard-for-desktop/articles/dashboard-designer/designing-dashboard-items/grid/columns/column-type-overview.html
https://en.wikipedia.org/wiki/%7b0%7d%5e
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 Drill Down 8.6.5

Let's see what product subcategories in the “Accessories” category were of positive 

dynamics. For this, in the “Data” tab on the toolbar, click the “Drill Down” icon 

 

and in the grid itself, in the “Columns” field under the “Category” hierarchy, drag the 

“Subcategory” hierarchy: 

 

Now by clicking the “Accessories” product category, we will see all the product 

subcategories that it includes: 
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In order to get back to the initial grid view click a grid icon: 

 

 Additional grid properties 8.6.6

In a “Design” tab of a Grid dashboard element the following toolbar is available: 

 
 Horizontal Lines – show horizontal grid lines; 

 Vertical Lines – show vertical grid lines; 

 Banded Rows – banded rows are not supported when cell merging is enabled; 

 

 Merge Cells – merge adjacent cells with identical data (“Drill Down” has to be off); 

 

 Column – show column headers; 

 Word Wrap; 

 AutoFit to Contents; 

 AutoFit to Grid; 

 Manual – adjust the width of columns manually. 
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By clicking a grid title, the following functionality will be available: 

 

 Fit to Content – fit the column width to its content; 

 Fit Width – specify the column width and fix it; 

 Column Width – specify the fixed column width; 

 Add Format Rule – possibility to choose one of the formatting ways form a dropdown list 

(the process is described in more details in abstract 8.18); 

 Edit Rules – possibility to change the existing highlighting rules; 

 Clear Rules – deletion of all the highlighting rules; 

 Add Total – possibility to display: 

 

 Clear Totals – delete all summaries. 

Let's display the minimum and maximum value of the “Reseller Sales Amount” measure in 

our grid: 

 

 Export 8.6.7

A grid can be exported into PDF, Excel or a picture format. Way are described in 

abstract 8.5.13. 
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 Chart 8.7

To create a chart, you need to click a “Chart” icon in the dashboard designer window on the 

toolbar: 

 

As a result, a new dashboard element appears: 

 

The left item contains the following chart parameters: 

 Values – measure, data is displayed on the Y-axis; 

 Argument – dimension, data is displayed on the Х-axis; 

 Series – dimension, data that is used to create series. 

In the field on the right there will be a chart itself. 
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Let us create a chart, which will show the sales volume of product categories by year. 

Having filled in the fields as in the picture below, you will get the following chart: 

 

Let us change its type: 
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A window of the following view will open: 

 

The first tab “Series Type” allows redefining a chart type.  Among all the suggested options, 

let us choose “Full-Stacker Bar”: 
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A “Common Options” tab offers following possibilities: 

 

 Plot on secondary axis – data is displayed secondary axis 

 Ignore empty points – not to display zero values in a chart; 

 Show point markers – for a chart of an “Area” type point markers are displayed. 

 

We will not change anything here. 

 

In a “Point Label Options” tab, the following possibilities are available: 

 



 

  

 382 

 Content: 

 Select All 

 Argument 

 Series Name 

 Value 

 Percent 

 Overlapping mode: 

 Hide overlapping labels – hide overlapping labels; 

 None – display all the labels; 

 Reposition  overlapping labels – hide overlapping labels regime is off (all the 

labels without overlapping will be shown). 

 Orientation: 

 Default – labels are located horizontally; 

 Rotate to the Right – labels rotation for 90 degrees clockwise; 

 Rotate to the Left - labels rotation for 90 degrees counterclockwise. 

 Bar options: 

 Show for zero values – to display or not to display zero values; 

 Position – labels position either outside or inside (for Histograms and 

Bubbles). 

Fill out the following tab as shown below: 

 



 

  

 383 

As a result, the report will have the following view: 

 

Let us add one more data panel: 
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To the existing chart, we add one more panel that displays the number of orders for all the 

same product categories by year. For this, drag the “Reseller Order Count” measure to the value bar, 

select the “Spline” type of the chart and set the following parameters on the remaining tabs: 

 

 

 

As a result, we will get the following chart: 
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 X/Y – Axis settings  8.7.1

The chart in the dashboard has two axes – “X” and “Y”. The “X”-axis is the axis of the 

arguments, and the “Y”-axis is the numerical axis of the measure value. The following options for 

chart are in the “Design” tab: 

 

 Rotate – rotate the diagram at 90° 

 “Х” – Axis Settings 

 “Y” – Axis Settings 

Let us have a look at the settings for each axis. 

For “Х”-axis, the following parameters are available: 

 

 Reverse – display values in descending order; 

 Enable zooming  

 Show X-axis 

 Show title 

 Default text – dimension name 

 Custom text – text, entered by a user 

 Limit visible points – a number of visible point on an axis. 
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For “Y”-axis, the following parameters are available: 

 

 Always show zero level 

 Reverse – rotate an axis at 180° 

 Show grid lines – to display or not to display grid lines 

 Show axis – show/hide an axis  

 Show title – to display or not to display a title; 

 Default text – dimension name 

 Custom text – text, entered by a user 

 Logarithmic scale – to display or not to display a logarithmic scale. 

 Legend 8.7.2

To change the location of the legend, go to the “Design” tab: 

 
The following functionality will be available on the toolbar: 

 Show Legend – to display or not to display a legend; 

 Legend location: 
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 Series Type 8.7.3

You can change the type of the row on the toolbar in a “Design” tab. 

 

The following chart types are available in the drop-down list: 

 

 Edit Colors 8.7.4

You can change the color of the chart elements in two ways: 

Way 1. Click an “Edit Colors” icon in the “Design” tab toolbar: 

 
Way 2. Click an “Edit Colors” icon in the “Home” tab toolbar: 
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In the window that appeared, select the required element and set the color for it: 

  

 Drill Down 8.7.5

Such a function as Drill Down is possible for charts. It is described in abstract 8.6.5 in more 

details. 

 Export 8.7.6

Charts can be printed and exported into PDF, Excel or an image. Ways to do this are 

described in abstract 8.5.13 
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 Scatter Chart 8.8

In order to create a scatter chart click a “Scatter Chart” icon in “Dashboard Designer” 

window toolbar: 

 

 An empty scatter chart will appear: 

 

A scatter chart contains the following fields: 

 “Х”-Axis – contains the data item against which the X-coordinates of data points are 

calculated; 

 “Y”-Axis – contains the data item against which the Y-coordinates of data points are 

calculated; 

 Weight – contains the data item whose values are used to calculate the weight of data 

points; 

 Argument – contains data items providing scatter chart arguments that are used to 

create data points. 
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Let us build a scatter that will display the values of the “Sales Amount” measure and “Gross 

Profit Margin” measure for product categories, and the size of the circle will correspond to the value 

of the “Gross Profit” measure. 

To do this, drag the “Sales Amount” measure to the “X”-axis, “Gross Profit Margin” 

measure to the “Y”-axis , “Gross Profit” to the “Weight” field, and drop the “Category” hierarchy 

into the argument: 

 

By default, a scatter chart does not contain the elements coloring. In order to color the 

elements, you need to select “Hue” from the drop-down list by right-clicking the “Category” 

hierarchy in the context menu: 
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As a result, a scatter chart will have the following view: 

 

Let us find out which subcategories of products of the “Bikes” category gave such a high 

profit. To do this, select the “Subcategory” hierarchy in the argument field, and enable the “Drill 

Down” in the “Data” tab: 
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By clicking the “Bikes” product category, we will see the number of product subcategories 

that it includes, and the corresponding measures values for them: 

 

 

Let us turn “Hue” on for subcategories as well: 

   



 

  

 394 

After that, a scatter chart will get back to its initial view. However, after clicking “Bikes” 

product category again, we will get the following view of a scatter chart: 

 

To return to the previous detail level (drill up), use the Drill Up button (the  icon). 

 X/Y – Axis settings  8.8.1

In a “Design” tab, there are the following scatter chart parameters: 

 

 Rotate  - rotate at 90° 

 “Х”-Axis Settings 

 “Y”-Axis Settings 

 

Note: axis properties are described in more details in abstract 8.7.1 
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 Point Labels 8.8.2

In order to display points, values in a scatter chart, you need to click the following icon in 

“Design” tab in a toolbar: 

 

As a result, a form with the following parameters will appear: 

 

 Show point labels – to display or not to display labels; 

 Content – labels values 

 Argument – point labels show argument values; 

 Weight – point labels show the weight summary value; 

 Values – point labels show summary values from “X” and “Y”-axes; 

 Argument and weight - point labels show the argument value and the 

corresponding weight summary value; 

 Argument and values - point labels show argument values and corresponding 

summary values. 

 Overlapping mode 

 Hide overlapping labels – if two or more labels overlap, some of them are 

automatically hidden to avoid overlapping; 

 None - the overlapping resolving algorithm is disabled; 

 Reposition overlapping labels - the default algorithm to re-position point 

labels in a random way, and avoid overlapping labels. 

 Orientation: 

 Default – A point label is displayed in its default orientation; 

 Rotate to the Right – A point label is rotated 90 degrees clockwise; 

 Rotate to the Left – A point label is rotated 90 degrees counter clockwise. 
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 Position 

 Outside – labels are located inside a point; 

 Insite – labels are located outside a point. 

For a scatter chart, you can also change legend's location and redefine coloring for toolbar 

elements. This process is described in more details in abstracts 8.7.2 and 8.7.4. 

 Drill Down 8.8.3

For a Scatter Chart such functionality as “Drill Down” is also available. Its working 

principle is described in abstract 8.6.5. 

 Export 8.8.4

When it is necessary, you can print or export a Scatter Chart into PDF, Excel or an image.  

 Export To PDF 

While exporting, the following options are available: 

 

 Page Layout – specifies the page orientation used to export a Scatter Chart dashboard 

item; 

 Size – specifies the standard paper size; 

 Show Title – specifies whether or not to apply the dashboard item caption to the 

exported document title; 

 Title – specifies the title of the exported document; 

 Size Mode – specifies the export size mode for the Scatter Chart dashboard item; 

 Include Filters / Parameters – allows you to include master filter values / parameter 

values to the exported document; 

 Position – specifies the position of the master filter and parameter values in the 

exported document. 
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 Export to Excel 

See abstract 8.5.13 

 Export to Image 

See abstract 8.5.13 

 Pies 8.9

In order to create Pies, click the following icon in a dashboard designer window: 

 

Let us create pies that will display the gross profit margin by product categories. For this, let 

us move the “Gross Profit Margin” measure into a value field, and “Category” into an argument: 
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Now let us have a look how “Gross Profit Margin” measure value has changed through the 

years. For this, let us move “Calendar Year” into rows: 

 

If necessary, you can quickly swap the value of an argument and a row by using the 

following icon on the toolbar: 

 

 Layout 8.9.1

In a “Design” tab, you can define the way to display pies elements: 

 

 Auto Arrange – by default, the “Auto Arrange” option is enabled, which 

automatically resizes pies to fit within the dashboard item; 
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 Arrange in Columns – place the elements in the given number of columns: 
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 Arrange in Rows – place the elements in the given number of rows: 
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 Labels 8.9.2

Pies display “data labels” that contain descriptions for pie segments, and 

provide “tooltips” with additional information: 

 

 

In “Data Labels” and “Tooltips” drop-down lists, you can choose one of the ways to display 

data values: 

 

Let us display the value of “Gross Profit Margin” in the data signatures of our pies, while in 

the tooltips - the share value, and display the signatures to the pies itself: 
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Pies will look the following: 

 

 Data Labels Position 8.9.3

Data Labels Position may be as follows: 

 

 Style 8.9.4

Pie has two ways to display: 

 

 Edit Colors 8.9.5

Default colors can be edited if needed. This process is described in more details in abstract 

8.7.4. 

 Drill Down 8.9.6

Such a function as Drill Down is available for pies. Its working principle is described in 

abstract 8.6.5. 

 Export 8.9.7

If needed, pies can be exported into PDF, Excel or an image. It is described in more details 

in abstract 8.5.13 
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  Gauges 8.10

In order to create a dashboard element called “Gauges” you need to click the following icon 

in a designer window toolbox of a dashboard: 

 

Gauges is a kind of an indicator, which displays the following values: target, actual, delta 

value. 

Target is a gauges arrow, “Actual” is a gauges sign on the scales, “Delta” is an indicator sign 

on a gauges. 

Let us have a look at gauges that have “Reseller Sales Amount” measure as a target, and 

“Internet Sales Amount” as a actual, and analyze them in terms of product categories. For this, fill 

in the fields in the following way: 

  

As a result, we will get some gauges: 
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 Delta 8.10.1

By default, a gauge shown the difference between an actual and a target. This difference is 

called delta: 

 

In order to change delta settings you need to click the following icon: 

 

A form with the following indicator parameters will appear: 
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Value type: 

 Actual Value – value of an actual measure; 

 Absolute Variation – difference between an actual and a target; 

 Percentage Variation – percent of difference between an actual and a target; 

 Percentage of Target – percent of an actual and a target. 

Result indication: 

 Greater is Good – The 'good' indication is displayed if the actual value exceeds the 

target value; if the target value exceeds the actual value, the 'bad' indication is 

displayed; 

 Less is Good – The 'bad' indication is displayed if the actual value exceeds the target 

value; if the target value exceeds the actual value, the 'good' indication is displayed; 

 Warning if Greater – A warning is displayed if the actual value exceeds the target 

value; otherwise, no indication is displayed; 

 Warning if Less – A warning is displayed if the target value exceeds the actual value; 

otherwise, no indication is displayed; 

 No Indication – Indication is not displayed.  

For the delta, you can set the threshold value, which will indicate the excess of the actual 

above the target. The threshold type can be percent or absolute. 

Let us display the percentage of difference between an actual and a target for our gauges. 

We are interested in those values for which the percentage of difference is greater than zero. For 

this, fill out the form as follows: 

 

As a result, we will get gauges of the following view: 
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 Gauge Scale 8.10.2

By default, the Gauge dashboard item automatically determines the range of the gauge 

scales based on the values they display. 

You can override this behavior and specify maximum and minimum values on the scale: 

 

 Layout 8.10.3

Different layout options are available for gauges. Principle and working method are 

described in abstract 8.9.1.  

 Style 8.10.4

The Gauge dashboard item allows you to select the gauge type: 

 

 Drill Down 8.10.5

Such a function ad “Drill Down” is available for indicators. Working principle of this 

functionality is described in abstract 8.6.5. 

 Export 8.10.6

You can print indicators as well as export them into PDF, Excel or an image. The ways are 

described in abstract 8.5.13. 
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 Cards 8.11

To create a “Cards” dashboard element, click the toolbar icon in the dashboard designer 

window: 

 

A “Cards” dashboard element is a series of cards, each of which displays the difference 

between two values (measures). 

Let's show the difference between the two measures “Reseller Sales Amount” and “Reseller 

Total Product Cost” for subcategories of products. For this, fill in the fields as follows: 

 

As a result, we received several cards that display: 

 



 

  

 408 

 Delta 8.11.1

In order to set or change the delta value, you must click (the  icon): 

 

In the opened form “Card Settings” go to the “Delta Options” tab: 

 

Then, specify the following settings: 

 Result indication: 

 Greater is good – the 'good' indication is displayed if the actual value exceeds the 

target value; if the target value exceeds the actual value, the 'bad' indication displays 

 



 

  

 409 

 Less is good – the 'bad' indication displays if the actual value exceeds the target 

value; if the target value exceeds the actual value, the 'good' indication displays 

 

 Warning if greater – a warning is displays only if the actual value exceeds the target 

value 

 

 Warning if less – a warning is displays only if the target value exceeds the actual 

value; otherwise, no indication is displayed 

 

 No Indication – indication is not displayed. 
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For the delta, you can set a threshold value, which will indicate an excess of an actual above 

a target. 

The threshold type can be percent or absolute. 

 Sparkline 8.11.2

Sparklines can be used to visualize the variation of actual or target values (for instance, over 

time). 

Let us analyze the change in actual value in terms of months of the year. For this, move the 

“Month of Year” hierarchy into the “Sparkline” field: 

 

https://documentation.devexpress.com/Dashboard/15373/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Designing-Dashboard-Items/Cards/Providing-Data
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Sparkline itself has the following parameters: 

 

 Sparkline view type – defines the sparkline’s view type. Sparkline data points can be 

represented as area, line, bars, or win and loss squares. 

 Highlight min/max points – specifies whether to highlight the minimum/maximum 

points of a sparkline; 

 Highlight start/end points – specifies whether to highlight the start/end points of a 

sparkline. 

 Card Layouts 8.11.3

To change a card's layout, click the “Options” button (the  icon) displayed next to the 

data item container in the Cards section: 

 

https://devexpress.github.io/dotnet-eud/dashboard-for-desktop/articles/dashboard-designer/designing-dashboard-items/cards/providing-data.html
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In the form that opens, the following layouts are available on the “Layout Options” tab: 

 

 Stretched – the Stretched layout template arranges card elements so that they occupy 

an entire card area 
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 Centered – the Centered layout template is used to center card elements so that they 

occupy a specified width/height 

 

 Compact – the Compact layout template is used to arrange card elements so that they 

occupy the minimum area 

 

 Lightweight – the Lightweight layout template displays the minimum set of elements 

within a card 
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For all layout types, you can change the visibility of its elements, or you can specify the 

display value type for data-bound elements: 

 

On the “Layout Options” tab, select the required layout type in the “Select template” list and 

specify its settings: 

 Min width – specifies the minimum width of the card content; 

 Max width – specifies the maximum width of the card content. Use the “Auto” option to 

determine the maximum width automatically; 

You can show/hide the following values and visual elements within the card: 

 Actual Value – a summary value for a measure placed in the Actual placeholder; 

 Title – displays values of the last (bottommost) dimension placed in 

the Series section; 

 Subtitle – displays combined values of all dimensions except the last (bottommost) 

dimension; 

 Percent Variation – a percent difference between the actual and target value; 

 Absolute Variation – an absolute difference between the actual and target value; 

 Delta Indicator – indicates whether the actual value is less or greater than the target 

value 

 Sparkline – visualizes the variation of actual or target values. 

 

https://devexpress.github.io/dotnet-eud/dashboard-for-desktop/articles/dashboard-designer/designing-dashboard-items/cards/providing-data.html
https://devexpress.github.io/dotnet-eud/dashboard-for-desktop/articles/dashboard-designer/designing-dashboard-items/cards/providing-data.html
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 Format Options 8.11.4

The Card dashboard item formats the actual and target values displayed within cards 

using format settings specified for data items. Click the options buttons (the  icon) displayed 

next to the data item container in the Cards section to change format settings for other values: 

 

In the invoked “Card Settings” dialog, go to the “Format Options” tab and use the “Select 

value type” option to specify which values’ format settings should change: 

 

 Cards Arrangement 8.11.5

The following display methods are available for the cards in the “Design” tab: 

 

The principle of functionality is similar to that of Pies – abstract 8.9.1 

https://devexpress.github.io/dotnet-eud/dashboard-for-desktop/articles/dashboard-designer/designing-dashboard-items/cards/providing-data.html
https://devexpress.github.io/dotnet-eud/dashboard-for-desktop/articles/dashboard-designer/data-shaping/formatting-data.html


 

  

 416 

 Drill Down 8.11.6

Such a function as Drill Down is available for Cards. The principle of this functional is 

described in abstract 8.6.5. 

 Export 8.11.7

Cards may be exported into PDF, Excel or an image. Ways to do this are described in 

abstract 8.5.13 

  Treemap 8.12

To create a Treemap, click the corresponding icon on the toolbar: 

 

Let us display the volume of sales by product categories. Having filled in the fields as in the 

picture below, we get a treemap of the following view: 
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Now add a “Subcategory” hierarchy into an “Argument” fields: 

 

Let us group the subcategories of one group of products: 
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As a result, a Treemap will look as follows: 

 

 Layout 8.12.1

The following methods of displaying Treemap tiles are available on the “Design” tab: 

 

 Slice and Dice - this layout algorithm divides the space between items, slicing it in the 

specified direction depending on item value; 

 Squarified - the Squarified algorithm arranges tiles so that their width/height ratio will be 

closer to 1; 

 Striped - this algorithm is a modified version of the Squarified algorithm. The difference 

here is that tiles are drawn side by side as columns or rows; 
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 Layout Direction - you can also set a layout direction to specify an arrangement of tiles 

depending on their sizes: 

 

 Labels 8.12.2

There are two types of labels in a Treemap: 

 Tiles Labels 

 Group Labels 

 

The Treemap displays labels that contain descriptions for tiles and groups, and provide 

tooltips with additional information: 
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Use buttons within the “Tile Labels” / “Group Labels” ribbon groups to manage tile and 

group labels, respectively. These buttons invoke the drop-down menu, which is similar for all 

buttons: 

 

 Edit Colors 8.12.3

For a treemap the Color Editor functionality is available. The principle of its functionality is 

described in abstract 8.7.4. 

 Export 8.12.4

Treemap may be exported into PDF, Excel or an image. The ways to do this are described in 

abstract 8.5.13 

  Filter Elements 8.13

Filter elements represent a special type of dashboard item that allows you to apply filtering 

to other dashboard items. 

To create a Filter dashboard element, click the icon: 

 

The following filters are available in the drop-down list: 

 

 Combo Box – the Combo Box dashboard item allows to select a value(s) from the 

drop-down list. 
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On the “Design” tab for this filter, there are two ways to select values: 

 

 Standard – allows to select only a single value: 

 

 Checked - allows to select multiple values in the invoked drop-down list: 

 

 List Box - the List Box dashboard item allows to select a value(s) from the list 
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On the “Design” tab for this filter, there are two ways to select values: 

 

 Checked – allows to select multiple values in the list box 

 

 Radio - allows to select only a single value in the radio group 

 

In addition, there is a possibility to enable filtering for all elements: 
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 Tree View - the “Tree View” dashboard item displays values in a hierarchical way 

and allows to expand/collapse nodes 

 

You can manage the initial expanded state of filter values using the “Auto Expand” button in 

the “Design” ribbon tab: 

 

Auto Expansion – the tree will be in the expanded state. 

For all types of filter available quick search: 
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  Range Filter 8.14

The “Range Filter” dashboard element as well as “Filtr” allows to apply filtering to other 

dashboard elements. 

 

This element displays a chart with selection thumbs that allow you to filter out values 

displayed along the argument axis: 
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This filter can be used for cross-filter data sources. For this, use the “Cross-Data-Source-

Filters” button on the “Data” tab: 

 

You also can not apply end-to-end filters to this element: 

 

You can create your own ranges of data. To do this, use either the context menu (right 

mouse button) or click on the  icon in the “Argument” field: 
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As a result, the “Edit Periods” window appears: 

 

The list on the left shows the list of ready periods that you can filter: 
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In order to add the selected period, use the  button or simply drag the period in the field 

on the right: 

 

This period will be added to the right pane of the Edit Periods dialog. The following settings 

are available for the added period: 

• Caption – title name for the period; 

• Period - displays the time interval of the date corresponding to the period; 

• Default - allows to use the selected period as the default value in the element of the Range 

Filter panel. 

 

You can create your own period. To do this, use the “Add Custom Period ...” button in the 

“Edit Periods” window: 
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As a result, a window appears in which you can add the following periods: 

 

For the year, quarter and month it is possible to set to display: 

 Previous Year/Quarter/Month; 

 This Year/Quarter/Month; 

 Next Year/Quarter/Month; 

 Last Year/Quarter/Month; 

 Next Year/Quarter/Month. 
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There is also a possibility to create a Custom period: 

 

This period allows to specify a period with user boundaries (“Start” and “End” point): 
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For start and end points, you can set the following parameters: 

 None – the start and end points will be equal to the start and end values from the 

visible range; 

 Fixed – possibility to select a specific value in the calendar; 

 Flow – allows to specify a floating period with interval and offset. “Interval” – 

indicates the interval between the current date and the required date, “Offset” – the 

number of such intervals: 
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 Group 8.15

The “Group” dashboard element allows you to merge several elements into a single group. 

To create a Group element, click the icon: 

 

Let us have a look at the working principle of this element on the example of two groups. 

First, we create two elements of the dashboard - a chart (of a “Spline Area” type) and a filter 

(of a “Tree View” type). For each of them, fill in fields with appropriate data: 
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Now create the first group (click the icon of the same name in the toolbar) and drag the chart 

and filter into it: 

 

Thus, we got a group, elements of which can interact with each other within this group and 

outside it. 

On the “Data” tab: 

 

 The “Master Filter” button allows you to specify whether the current group allows 

you to filter external dashboard items using master filter items contained within the 

group. If this option is disabled, master filter items contained within the group can 

filter only dashboard items from this group; 

 The “Ignore Master Filters” button allows you to isolate dashboard items contained 

within the group from being filtered using external master filter items. 

For the first group, let us leave the filter on – “Ignore Master filters”. 
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Now let us create the second group. It will consist of a chart and two filters (“List Box” and 

“Combo Box”): 

 

We paint subcategories of the same groups of products in the same color: 

 

Now let us create a filter – “Combo box”: 
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The second filter will be called “List Box”: 

 

For a “List Box” on the “Data” tab disable “Ignore Master Filters” button: 

 

Create a second group and drag the chart and filters into it: 

 

For this group on the “Data” tab, we also leave an active “Ignore Master Filters” filter. 
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Thus, we got two independent groups: 
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The first shows the sales volume of the groups of products depending on the month of the 

year and country, and the second shows the sales volume of a particular group of products by 

subcategories: 
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 Images 8.16

An image can be one of the elements of a dashboard. To add an image, click the 

corresponding icon in the toolbar: 

 

An «Interactive Dashboard» allows to create two types of image elements: 

 

 Image 

 Bound Image 

 Image 8.16.1

To add an “Image” element, choose the following sub-item: 

 

An empty field appears in the dashboard designer window: 
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Now, to add an image, go to the “Design” tab and click an “Import Image” icon: 

 

In the opened form, specify the location of the file and click an «OK» button. As a result, the 

dashboard will look the following: 

 

If necessary, the size and location of the image can be changed: 

 

An image may be exported into PDF or an image. The ways to this are described in abstract 

8.5.13. 
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 Bound Image 8.16.2

To add a “Bound Images” item, select the following sub-item: 

 

A new element appears in the designer window: 

 

Next, you need to choose how to bind the data to the image by clicking the  

“Options”  button next to an attribute. The following options will be available in the 

opened window: 

 

 Binary Array – use this mode if images are stored in the data source as byte arrays; 
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 URI – use this mode to locate images accessible by a predefined URI. In this case, 

the data source field should return strings that are parts of URIs to these images. 

For instance, the URI pattern in the form below specifies the path to the folder containing 

the required images: 

 

Data source field values will be inserted to the position of the {0} placeholder. Thus, the 

Bound Image maps the current dimension value with the image placed at the specified URI. 

 

For example, let us display flags for each country for the following table: 
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To start with, we will place the files with the corresponding image and name in the folder: 

 

We will create a new “Bound Images” element with the “Country” attribute: 
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The form of data binding will be filled with the following data: 

 

Now, all is left is to insert the data source field values into the {0} placeholder position: 
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As a result, we will get an interactive dashboard in which the table with the “Country” 

hierarchy will be linked to the image: 

 

  Text Box 8.17

“Text Box” can be one of the elements of the dashboard. Click the corresponding icon on the 

toolbar: 

 

In the designer window, an empty text field appears: 
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To insert or edit text, go to the “Design” menu tab and click an “Edit” icon: 

 

Or use the corresponding item in the context menu: 

 

The text editing form with the following set of tools will appear: 

 

The Text can be exported into PDF or an image. 
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The “Text” element can be bound to the data of other dashboard elements. Let us add a 

“Text” element to the dashboard, and let’s alternately drop the following values of “Product”, “Unit 

Price” and “Description” in the value field: 

 

Now move to the “Design” tab and click an “Edit” button: 

 

In the text field, insert the following data: 
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Then place the cursor at the end of the “Name” text and right-click on it. Select “Insert 

Field” from the context menu: 

 

Now click on the “Select value” field and select the “Product” value: 

 

Repeat the same steps for the “Price” and “Description” fields: 
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Now click on the “Edit” button again to exit the edit mode. The following data will be 

displayed in the “Text Box”: 

 

Let's use filters to make the “Text Box” field more dynamic. Add two filters of the List type 

with the following fields to the dashboard: 
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And, finally let’s add the “Images” element with the data binding and we throw the 

“LargePhoto” in the value field: 
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 Conditional Formatting 8.18

For “Grid” and “Pivot” dashboard elements, it is possible to set the format rules. 

You can create a new format rule in two ways: 

Way 1. Click an “Option” button next to the appropriate dimension/measure: 

 

 

Way 2. Right-click on the table header: 
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 Format Rule: Value 8.18.1

Value can be one of the highlight rules: 

 
Let us have a look at it on an example of the pivot table: 
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Let us select the totals of those product categories for which the values of the “Sales 

Amount” measure are more than $ 1 million: 

 

The following form appears: 
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This form contains the following parameters specific to Pivot: 

 Format values that are greater than… – set value; 

 Appearance/Icons – the “Appearance” tab allows you to choose the predefined 

background color/font, the “Icons” tab allows you to add the predefined icon; 

 Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

 Auto – identifies the default level. For the Pivot dashboard 

item, auto identifies the “First Level”; 

 First level – first level values are used to apply conditional formatting; 

 Last level – the last level values are used to apply conditional formatting; 

 All levels – all pivot data cells are used to apply conditional formatting; 

 Specific level – values from the specific level are used to apply conditional 

formatting. 

 Row/Column dimension – 

 if you specified the Intersection mode as “Specific Level”, use the “Row dimension” and “Column 

dimension” combo boxes to set the specific level; 

 Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

 Apply to row/column – apply to the entire row / to the entire column. 

Fill out this form as follows: 
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As a result, the “Pivot” table will look the following: 

 

To edit an existing highlight rule, click the “Options” icon next to the measure: 
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In the window that appears, double-click the rule or click an “Edit” button: 

 

To delete the format rule, select the necessary format rule in the list in the “Edit Rules” 

window and click the “Delete” button:  
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If necessary, the rule can be temporarily disabled by unchecking the corresponding rule: 

 

 Format Rule: Top N / Bottom N  8.18.2

The “Top-Bottom” format conditions allow you to highlight a specific number of 

topmost/bottommost values. You can specify this number as an absolute or percent value: 
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For example, let us select 4 quarters for which the “Sales Amount” measure values were the 

worst. Select the type of “Bottom N” highlight and fill out the form as follows: 
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Pivot will look like this: 
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Now let us check those product categories, the profit from which amounted to 90% of the 

total profit. For this, select the “Top N” highlight type and fill out the form as follows: 
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We get the following Pivot: 

 

Two product categories – “Bikes” and “Components” - gave 90% out of all profits. 

 Format Rule: Average 8.18.3

The “Average” format conditions allow you to highlight values above or below an average 

value: 
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 Format Rule: Expression 8.18.4

An “Expression” format condition allows you to use complex conditions to apply 

formatting:  
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 Format Rule: Icon Ranges 8.18.5

Icon “Ranges” allow you to use predefined or custom sets of icons to apply conditional 

formatting to different ranges of values: 

 
For example, let us select the 4-range highlight for the “Gross Profit” measure: 
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The following options are available in the appeared window: 

 

 Format style – the “Format Style” combo box allows you to change the icon set used 

to apply formatting; 

 Use % ranges – the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 

 Range field with set values: 
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Use the «Add» and «Delete» buttons to add new ranges or delete the selected range 

respectively. Note that new range is added below the selected range: 

 

To change the icon displayed for values corresponding to the specified range, click the 

button next to the required icon and select a new icon: 

 

 Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

 Auto – identifies the default level. For the Pivot dashboard 

item, “Auto” identifies the “First Level”; 

 First level – first level values are used to apply conditional formatting; 

 Last level – the last level values are used to apply conditional formatting; 

 All levels – all pivot data cells are used to apply conditional formatting; 

 Specific level – values from the specific level are used to apply conditional 

formatting. 

 Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

 Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

 Apply to row/column – apply to the entire row / to the entire column. 
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Fill in the form with the following data: 
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As a result, the pivot table will look the following: 

 

 Format Rule: Color Ranges 8.18.6

To format values according to the required condition, click the data item menu button, select 

“Add Format Rule”| “Color Ranges” and choose the required color set: 
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The working principle is the same as for the “Format Rule: Icon Ranges” highlight rule 

(abstract 8.18.5): 
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 Format Rule: Gradient Ranges 8.18.7

“Gradient Ranges” allow you to use predefined color gradients to apply conditional 

formatting to different ranges of values. You can also use specific colors to generate custom 

gradients.: 
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The form of the gradient highlight looks the following 

 

The following options will be available in the appeared window: 

 Number of ranges – “Number of ranges” allows you to specify the number of ranges 

used to classify values. Click the “Generate Ranges” button to generate a new 

gradient scale according to the specified number of ranges; 

 Use % ranges – the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 
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 Range field with specified ranges: 

 

 Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

 Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

 First level – first level values are used to apply conditional formatting; 

 Last level – the last level values are used to apply conditional formatting; 

 All levels – all pivot data cells are used to apply conditional formatting; 

 Specific level – values from the specific level are used to apply conditional 

formatting. 

 Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

 Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

 Apply to row/column – apply to the entire row / to the entire column. 
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 Format Rule: Bar 8.18.8

The “Bar” format condition allows you to visualize numeric values using bars. You can also 

paint bars corresponding to positive and negative values using different colors: 

 

This dialog allows you to change the following options specific to the “Bar” format 

condition: 
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 Min/Max – by default, lengths of the shortest and longest bars correspond to 

minimum and maximum values, respectively. If necessary, you can specify values 

corresponding to the shortest and longest bars manually. To do this, change the type 

of minimum/maximum value from “Automatic” to “Number or Percent”, and specify 

the required values; 

 Style Settings – “Style Settings” and “Negative Style Settings” allow you to specify 

style settings used to color data bars corresponding to positive and negative values, 

respectively; 

 Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

 Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

 First level – first level values are used to apply conditional formatting; 

 Last level – the last level values are used to apply conditional formatting; 

 All levels – all pivot data cells are used to apply conditional formatting; 

 Specific level – values from the specific level are used to apply conditional 

formatting. 

 Row/Column dimension - if you specified the Intersection mode as Specific Level, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

 Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

 Apply to row/column – apply to the entire row / to the entire column; 

 Allow negative axis – the “Allow negative axis” option allows you to specify 

whether negative data bars are displayed in the direction opposite to the positive data 

bars; 

 Draw axis – the “Draw axis” option specifies whether to draw the vertical axis 

between positive and negative data bars; 

 Show bar only – the “Show bar only” option specifies whether to show bars without 

corresponding values. 

 

Let us look at this type of highlight on the example of the “Pivot” table: 
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Let us add a highlight rule for the “Reseller Gross Profit” measure: 
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Fill out the form as follows: 
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As a result, we will get the following table: 

 

 Format Rule: Bar Color Range 8.18.9

“Bar Color Ranges” allow you to visualize numeric values using bars whose colors are 

contained in the specified color set: 
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This dialog allows you to change the following options specific to “Bar Color Ranges”: 

 

The following options will be available in the appeared window: 

 Format style – the “Format Style” combo box allows you to change the color set used 

to apply formatting; 

 Use % ranges – the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 
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 Range field with specifies values: 

 

Use the «Add» and «Delete» buttons to add new ranges or delete the selected range 

respectively. Note that new range is added below the selected range: 

 

To change the icon displayed for values corresponding to the specified range, click the 

button next to the required icon and select a new icon: 

 

 Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

 Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

 First level – first level values are used to apply conditional formatting; 

 Last level – the last level values are used to apply conditional formatting; 

 All levels – all pivot data cells are used to apply conditional formatting; 
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 Specific level – values from the specific level are used to apply conditional 

formatting. 

 Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

 Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

 Apply to row/column – apply to the entire row / to the entire column; 

 Allow negative axis – the “Allow negative axis” option allows you to specify 

whether negative data bars are displayed in the direction opposite to the positive data 

bars; 

 Draw axis – the “Draw axis” option specifies whether to draw the vertical axis 

between positive and negative data bars; 

 Show bar only – the “Show bar” only option specifies whether to show bars without 

corresponding values. 

 Format Rule: Bar Gradient Ranges 8.18.10

Bar Gradient Ranges allow you to visualize numeric values using bars whose colors are 

contained in the specified color gradient: 
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This dialog allows you to change the following options specific to “Bar Gradient Ranges”: 

 

 Number of ranges – “Number of ranges” allows you to specify the number of ranges 

used to classify values. Click the Generate Ranges button to generate a new gradient 

scale according to the specified number of ranges; 

 Use % ranges - the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 

 Range field with specified values: 
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 Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

 Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

 First level – first level values are used to apply conditional formatting; 

 Last level – the last level values are used to apply conditional formatting; 

 All levels – all pivot data cells are used to apply conditional formatting; 

 Specific level – values from the specific level are used to apply conditional 

formatting. 

 Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

 Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

 Apply to row/column – apply to the entire row / to the entire column; 

 Allow negative axis – the “Allow negative axis” option allows you to specify 

whether negative data bars are displayed in the direction opposite to the positive data 

bars; 

 Draw axis – the “Draw axis” option specifies whether to draw the vertical axis 

between positive and negative data bars; 

 Show bar only – the “Show bar” only option specifies whether to show bars without 

corresponding values. 
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 Top N 8.19

The “Top N” feature allows you to display only a limited number of values that correspond 

to the highest or lowest values of a particular measure 

Let us consider the working principle of the given functionality on an example of a grid (the 

highlight rule - line color range): 

 

https://documentation.devexpress.com/Dashboard/116538/Main-Features/Data-Shaping/Top-N
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We display only 7 subcategories with the best values of “Order Count” measure: 

 

The following parameters are available in the form: 

 

 Enabled – enables/disables this functionality; 

 Mode – specifies whether top or bottom values should be displayed; 

 Count – the number of values to be displayed; 

 Measure – the parameter according to which the top or bottom values will be 

determined. 
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Fill out the form as follows: 

 

As a result, the table looks the following: 
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And now let us add the “Category” dimension to the columns and we get the following 

result: 

 

Now we have 7 best “Order Count” measure indicators for each product category. 
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 Sorting 8.20

Let us sort the table obtained earlier in the decreasing order of the “Order Count” measure. 

For this, click in the right corner of the table next to an icon: 

 

The column with the Order Count measure is sorted in a descending order: 

 

Having clicked again, we get the opposite result (an increase of the “Order Count” measure). 
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To sort the hierarchy alphabetically, you need to open the context menu: 

 

By selecting the “Sort Descending” method, we get a table with category names sorted in a 

descending order: 
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If necessary, you can disable sorting: 

 

OLAP Sorting specific: 

 

 (Value) – sorting is performed by member values; 

 (Display Text) – sorting is performed by captions associated with members; 

 (Key) – sorting is performed by member keys; 

 (ID) – sorting is performed by member IDs. 
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 Formatting Data 8.21

 Formatting Numeric Values 8.21.1

You can change the data format. This functionality is available on the “Dashboard Designer 

toolbar”: 

 

To specify a format for numeric values, select “Format” from the data item menu: 

 

This invokes the “Numeric Format” window: 
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Types of formats can be as follows: 

 

Other format settings are in effect for only specific format types: 

 Unit – the unit to which values should be converted; 

 Precision – the number of fractional digits that should be displayed; 

 Currency – defines the currency sign and format settings that should be used to 

display currency values; 

 Culture – for currencies used in a region with several cultures, specifies the culture 

that defines format settings 

 Include group separator – specifies whether or not separators should be inserted 

between digit groups. 



 

  

 489 

 Formatting Date-Time Values 8.21.2

For date and time values, this functionality has the following parameters: 

 

 Currency Formatting Specifics 8.21.3

The «Interactive dashboard» allows you to specify a currency format at two levels: for the 

entire dashboard and for individual data items: 

 Data Item Currency – to specify which currency to use for a particular data item, 

select “Format” from the data item menu: 
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In the “Numeric Format” dialog, select “Currency” in the “Format type” field and use 

the “Currency” combo box to select the required currency: 

 

For regions with several cultures, you can also select the culture that will be used to format 

currency values: 
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You can also apply the default dashboard currency by selecting «Use dashboard settings» in 

the “Currency” field: 

 

 Dashboard Currency 

You can also specify the default currency for the dashboard. This setting will be applied to 

dashboard items that have no currency defined. 

To set the dashboard currency, click the “Currency” button on the toolbar: 

 

This invokes the Dashboard Currency window. In this window, select the required currency 

using the “Currency” combo box: 
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 Parameters 8.22

The parameter is a dashboard element that allows to dynamically influence the “Expression” 

highlight rule. 

In order to create a parameter, click the toolbar icon: 

 

The following window opens: 
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To add the parameter, click the «Add» button. The following parameters are displayed in the 

window: 

 

 Visible – specifies whether or not the parameter editor is visible in the dashboard 

Parameters dialog; 

 Allow Null –specifies whether or a not null value can be passed as a parameter value;  

 Allow Multiselect – specifies whether or not multi-selection is enabled for the current 

parameter. The following limitations are applied to parameters with multi-selection enabled. 

 Use the “is any of” or “is none of” operators to pass a multi-select parameter to 

a filter criteria or to the Expression format condition. 

 Use the “In” or “Not In” operators to pass a multi-select parameter to a calculated 

field expression. 

 Custom SQL queries do not support multi-select parameters. 

 Stored procedures used in SQL and Entity Framework data sources do not support 

multi-select parameters. 

 Name – Specifies the parameter name: 

 A name can contain letters, numbers and underscores. 

 A name cannot contain spaces. 

 A name cannot be an empty string. 

 The dashboard cannot contain parameters with the same name. 

 Names are case-sensitive. For example, you can create the 

names Parameter and PARAMETER. 

 Description – specifies the parameter's description displayed; 

 Look-Up Settings – specifies the parameter's look-up editor settings; 

 Type – specifies the parameter type; 

https://documentation.devexpress.com/Dashboard/CustomDocument16171.aspx
https://documentation.devexpress.com/Dashboard/CustomDocument16171.aspx
https://documentation.devexpress.com/Dashboard/15695/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Data-Shaping/Filtering
https://documentation.devexpress.com/Dashboard/114409/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Appearance-Customization/Conditional-Formatting/Expression
https://documentation.devexpress.com/Dashboard/16134/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Providing-Data/Calculated-Fields
https://documentation.devexpress.com/Dashboard/16134/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Providing-Data/Calculated-Fields
https://documentation.devexpress.com/Dashboard/115212/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Providing-Data/SQL-Data-Source/Working-with-Data/Custom-SQL-Queries
https://documentation.devexpress.com/Dashboard/113946/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Providing-Data/SQL-Data-Source/Working-with-Data/Stored-Procedures
https://documentation.devexpress.com/Dashboard/114587/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Providing-Data/Entity-Framework-Data-Source/Stored-Procedures
https://documentation.devexpress.com/#Dashboard/CustomDocument16169/Look-Up Editor Settings
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 Value – specifies the default parameter’s value(s). 

Note that when “Allow Multiselect” is set to “true”, the “Value” option allows you to select 

multiple parameter values. 

 

Let us create a setting that highlights the “Reseller Sales Amount” value of more than 

$500,000, but less than $ 1 million for all product subcategories. 

First, we add a table with the following values: 
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Create two parameters and fill in the fields as follows:  
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For “Reseller Sales Amount”, create an “Expression” highlight rule with the following 

parameters: 

 

As a result, the first parameter from the list is displayed in the value field: 
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Similarly, double-click the second value field: 

 

The first parameter will be displayed again, click it and select the “Sales2” parameter in the 

opened list: 
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It is only left to choose the color of highlight on the panel: 
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Now all the values of the “Reseller Sales Amount” measure that are higher than $ 500 000 

but lower than $ 1 million for all product subcategories are highlighted in the table: 

 

Now let us change the range of values: Sales1 = $ 200 000, and Sales2 = $ 2 million. 
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For this, click the “Parameters” icon in the toolbar: 

 

In the opened window enter the corresponding values for each parameter: 
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As a result, we get a table where all the values of “Reseller Sales Amount” measure for more 

than $ 200 000 but less than $ 1 million are highlighted: 
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 Hidden data items 8.23

Each dashboard element in the “Data Items” field contains an additional 

field – “Hidden Data Items”: 

 

Elements of this field can be used as a context. 

Let us consider it on an example of one of the previous tables: 
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We display the 7 best values of the “Order Count” measure for each product category only 

for year 2018. For this, drop the “Calendar Year” hierarchy into the “Hidden Data Items” field: 

 

Now, from the context menu (by a right-click), select “Edit Filter” icon: 
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In the drop-down list, select the “Calendar Year” hierarchy: 

 

And then specify the year: 
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Now the table displays the 7 best values of the “Order Count” measure for each product 

category for year 2018 only: 
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 Aggregations 8.24

In the interactive dashboard, the following aggregate functions are available: 

 

 Count – returns the number of values 

  Count Distinct – returns the number of distinct values 

  Sum – returns the sum of all values 

 Min – returns the minimum value across all records 

 Max – returns the maximum value across all records 

 Average – Returns the average of all the values in the expression. 

 StdDev – Mean Square Deviation 

 StdDev P – dispersion 

 Var – Non-shifted dispersion 

 VarP – returns the variance of a population where the population is the entire data to 

be summarized. 

 Median 

 Mode 
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 Calculated Members 8.25

The «Interactive Dashboard» allows to add the following calculated elements based on the 

ready-made measures: 

 

 Percent of Column Grand Total 

 Percent of Row Grand Total 

 Percent of Grand Total 

 Running Summary along Columns 

 Running Summary along Rows 

 Difference along Columns 

 Difference along Rows 

 Percentage Difference along Columns 

 Percentage Difference along Rows 

 Rank along Columns 
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 Rank along Rows 

 Rank along Cells 

You can create your own computational element: 
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As a result, “Customize Calculation” form appears: 

 

 Running Total 8.25.1

The “Running Total” calculation can be used to compute a cumulative total for the  

specified measure: 

 

 Running along – the direction that is used to calculate running totals; 

 Summary function – specifies a summary function used to apply calculation. 
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 In the table below, we can see sub-total sales for all months: 

 

 Moving Calculation 8.25.2

The “Moving calculation” uses neighboring values to calculate a total: 

 

 Moving along – specifies a window and direction used to apply a calculation; 

 Summary function – specifies a summary function used to apply calculation. 

https://documentation.devexpress.com/Dashboard/116031/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Data-Analysis/Window-Calculations/Window-Calculations-Overview
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 Start/End offset – initial and final offsets from the current value in process: 

  

In the table below, we can see the moving average for all months with an initial offset of -2 

and a final offset of 0: 

 

 Difference 8.25.3

The “Difference” calculation can be used to compute the difference between measure 

values: 

 

 Calculate along – specifies a window and direction used to calculate differences; 

 Difference from – select value 

 Previous 

 Next 

 First 

https://documentation.devexpress.com/Dashboard/116031/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Data-Analysis/Window-Calculations/Window-Calculations-Overview
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 Last 

 Percentage Difference – show the percentage difference. 

 

In the table below, we can see an absolute value of the difference between the months 

(Difference from - Previous): 

 

 Percent Of Total 8.25.4

A calculation is used to compute a percentage of the total for the specified measure: 

 

 Percent of total – specifies a window and direction used to apply a Percent of Total 

calculation. 

https://documentation.devexpress.com/Dashboard/116031/Creating-Dashboards/Creating-Dashboards-in-the-WinForms-Designer/Data-Analysis/Window-Calculations/Window-Calculations-Overview
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Below we can see the table that displays the contribution of individual monthly sales to total 

sales: 

 

 Rank 8.25.5

Use the “Rank” calculation to compute rankings for the specified measure: 

 

 Rank along – specifies a window and direction used to rank values; 

 Rank type 

 Unique 

 Competition 

 Dense 

 Modified 

 Percentile 
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 Order – ranking order 

 Ascending 

 Descending 

 

Below we can see the table that displays the ranking of sales for particular years in 

descending order:  

 

 Expression 8.25.6

With such choice, you can create your own expression using the necessary functions. 

To do this, click the “Edit in Expression Editor” button: 
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In the window that appears, write the appropriate expression: 
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 Interactive Dashboard Filtering 8.26

The «Interactive Dashboard» allows you to use any data aware dashboard item as a filter for 

other dashboard items: 

 

To reset filtering, use the “Clear Master Filter” button (the  icon). 

You can prevent specific dashboard items from being affected by “Master Filters”. To do 

this, use the “Ignore Master Filters” button: 
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 Dashboard Title 8.27

The “Dashboard Title” is located at the top of the dashboard surface. It can contain text or 

image content: 

 

You can change title settings by clicking the “Title” button: 

 



 

  

 518 

This dialog allows you to specify the following options: 

 

 Visible – specifies whether or not the dashboard title is visible; 

 Show Master Filter state – specifies whether or not to show the state of master filter 

items in the dashboard title; 

 Text – title text; 

 Alignment – specifies the alignment of the dashboard title; 

 Images – allows you to specify the image displayed within the dashboard title; 

When you hover over the filter icon ( ), all master filters applied to the dashboard are 

displayed in the invoked popup: 

 



 

  

 519 

 Dashboard Item Caption 8.28

The title of the dashboard element is located at the top of the dashboard and contains the 

following information: 

 

To edit the title of the dashboard element, select the Edit Names item in the context menu of 

the element: 
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 Dashboard Items Layout 8.29

The “Dashboard Designer” provides the capability to arrange and resize dashboard items 

and groups in various ways, using simple drag-and-drop operations: 
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You can change the position of a dashboard item by using drag-and-drop: 

 

 Undo and Redo Operations 8.30

In the «Interactive Dashboard» it is possible to undo and redo the actions performed on the 

dashboard. To undo/redo the last action, use the following buttons: 

 

To undo/redo several actions at once, click the arrow next to “Undo” / “Redo” button and 

select the actions in the list that you want to undo/redo 
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 Automatic and Manual Updates 8.31

The option “Automatic Updates” is available on the toolbar of the «Interactive Dashboard»: 

 

If this option is enabled, then all changes to the page structure will immediately display 

updated data. If this option is disabled, you can first modify the page as you like, and then click the 

button on the Button toolbar to send a request to the server for data: 
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 Interactive shared dashboards 8.32

After you created a number of dashboards, you can share them. To do this, right-click on the 

name of the dashboard and select an appropriate menu item: 

 

After that, other users and administrator will see your page in the list of shared dashboards. 


